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Calibration of accelerometer described
F.A.Q. updated
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Refreshed links
Player feature described
IMU feature described
Minor fixes

1. Executive summary
Marvelmind Indoor Navigation System is an off-the-shelf indoor navigation system, designed
to provide precise (±2cm) location data to autonomous robots, vehicles (AGV), and copters.
It can also be used to track moving objects via mobile beacons attached to them. Other
applications include, for example, forklifts, virtual reality (VR) systems, helmets for
construction workers or miners, etc.
The navigation system consists of a network of stationary ultrasonic beacons interconnected
via radio interface in a license-free band, one or more mobile beacons installed on objects to
be tracked and modem providing gateway to the system from PC or other computers.
Mobile beacon’s location is calculated based on a propagation delay of an ultrasonic pulses
(Time-Of-Flight or TOF) between stationary and mobile beacons using trilateration algorithm.
The system can build the map of stationary beacons automatically . In simple cases, no
additional manual data input or any manual distance measurements are required. This map
formed once can be frozen and stored in modem’s memory and the system becomes fully
active within 7 to 10 seconds after the modem is powered.

Fig. 1: Example of Starter Set based on Super-Beacons

Minimum configuration requirements to ensure optimal performance of the Marvelmind
Indoor Navigation System:
-
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For 3D (X, Y, Z) tracking: an unobstructed line of sight (hearing) between a mobile beacon
and 3 or more stationary beacons within 30 meters
For 2D (X, Y) tracking - an unobstructed line of sight (hearing) between a mobile beacon
and 2 or more stationary beacons within 30 meters

1.1.

Key capabilities:

Parameter
Distance between
beacons

Coverage area

Location precision

Location update
rate

Technical Specifications

-

Reaches up to 50 meters and up to 100 meters with horn under laboratory conditions (MiniRX or Super-Beacon to Super-Beacon with RX4 only)

-

Recommended distance is 30 meters (Transducer4 on the first beacon is looking straight at
the Transducer4 on the second beacon, other transducers are switched off)

-

Reaches up to 1000m2 with the Starter Set configurations

-

Absolute: 1–3% of the distance to the beacons
Differential precision: ±2cm

-

1/20Hz to 25Hz (Ultrasonic based only)
100Hz with ultrasonic + IMU fusion enabled (Only for Beacons HW v4.9-IMU-Discontinued)
Can be set manually via Dashboard software
Depends on the distance between mobile and stationary beacons (shorter distance—
higher update rate)
Depends on the number of mobile beacons (Non-Inverse Architecture; for Inverse
Architecture no such dependency)
Depends on the radio profile (500kbps, 153kbps, 38kbps)
Slightly depends on the number of stationary beacons—dependence is not the same as for
mobile beacons

Power supply

Coverage for larger territories is provided using submap – like cells in cellular networks

Internal: 1000mAh LiPo battery (Super-Beacon)

-

Battery lifetime: from 2 days to several months depending on the mode of operations

*For other types of beacons look to the comparison table
External: micro USB – recommended for permanent use
Weight

Mobile beacon (Super-Beacon) from the starter set:

-

59 grams (including 1000mAh battery, Super-Beacon housing and 50mm antenna)
27 grams (Super-Beacon, bare board w/o battery)

*For other types of beacons look to the comparison table
Beacon size

Size: 55x55x33mm (with 50mm antenna: 55x55x65mm) (Super-Beacon)
*For other types of beacons look to the comparison table
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1.2.

Legend

Legend chapter contains small icons and signs to highlight some key points of the text.
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-

Important

-

For experienced users

-

Demo or Help video

-

Useful link

2. Basics of the system
Here are examples of the Starter Sets

2.1.

:

What’s in the box
2.1.1. Starter Set Super-MP-3D:
-

4 x Stationary Super-Beacons with different frequences (19kHz, 22kHz, 25kHz,
28kHz, 31kHz, 34kHz, 37kHz, 45kHz). Can be used as AI and NIA.

-

1 x Mobile Super-Beacon

-

1 x Modem v5.1 supporting up to 250 beacons

2.1.2. Starter Set IA-04-2D-Badge:
-

2 x Super-Beacons – 915/868 MHz with different ultrasonic frequencies (f1 and f2 –
usually, 25kHz and 31kHz).

-

1 x Marvelmind Badge – 915/868 MHz as mobile beacon

-

1 x Modem HW v5.1 – 915/868 MHz as central controller of the system

*This is just an example of two starter sets.
You can see more options on our website: Products
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2.2.

Indoor Navigation System architectures

Marvelmind Indoor Navigation System provides high-precision (±2cm) indoor
coordinates for autonomous robots and systems (“indoor GPS”). A brief description of
the key elements of the system is given on the scheme below.
IA and NIA SW differs
For IA you should use stationary beacons with different frequencies
Below you can see 2 types of architectures: Non-Inverse (NIA) and Inverse (IA):
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Here is a tutorial video about architectures:
-
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Help: Inverse Architectures (IA) vs. Non-Inverse Architectures (NIA)

Architectures’ elements

2.3.

A map is a system unit that includes submaps, stationary beacons and service zones
within which positioning of mobile beacons is ensured by ultrasonic signals from the
stationary beacons of this submap.
Handover zone (marked blue)

Map

Mobile beacon

Service zone Submap0

Service zone Submap1

14

Stationary beacon
10

11

12

Submap0 tab
Submap1 tab
Submap0 (beacon 10 + 11)

Submap1 (beacon 11 + 12)

The main parameters of a submap are its size, frequencies and TDMA position of
stationary beacons, by which mobile beacons can not only be positioned, but also
determine in which submap the mobile beacon is located.

Here is the main tutorial video about maps:
-
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Help: submaps, service zones, handover zones

2.4.

Indoor “GPS” System close-up and internal view

Here, you can see how system elements look like
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-

Super-Beacon:

-

Modem HW v5.1:

-

Beacon Mini-RX:
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-

Beacon Mini-TX:

-

Beacon Industrial-RX:

-

Beacon Industrial-TX-Metal:

-
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Industrial Super-Beacon-Plastic:

3. System elements
Here are represented core elements required for stable working of the system:

3.1.

Control system (Dashboard)

Dashboard is a Windows/Linux app for setting up and tuning the system. It also allows
to get the tracking data.

-

General app for SW update and initial setting up the system

-

Contains a lot of tracking display features

-

Very deep tuning and setting abilities

-

All new features available in the Dashboard app

You can get data without the Dashboard, the whole system after setting up can work
without it
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3.2.
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Stationary beacon
-

Usually mounted on walls or ceilings above the robot
with ultrasonic sensors facing down—to provide the
most robust unobstructed ultrasonic signal coverage
to the robot. However, for automatic landing and
indoor navigation of copters, for example, it is
recommended to install mobile beacon horizontally
on the belly of the copter so that the beacon would
be looking downwards

-

The position and orientation of the beacons should
be chosen in a way that provides maximum
ultrasonic signal coverage. System efficacy strongly
depends on the quality of ultrasonic signal
Fig.1: Super-Beacon as an example
received by stationary beacons

-

Stationary beacons emit and receive ultrasound during the map configuration
period. In non-inverse architecture once the map is formed and frozen, they only
work as receivers. In inverse architecture they only work as transmitters.

-

Stationary beacons have no exterior differences with regard to mobile beacons

-

The mobile and stationary beacons can be easily interchanged during configuration
in the Dashboard

-

There are 433MHz(out of production, get bug-fixing SW update only) and
868/915MHz versions available. A proprietary radio protocol is used for
communication and synchronization. Other ISM bands are available upon request
as well

-

Stationary beacon can be equipped with full-size 165mm antenna , which provides
more robust radio connection between modem and beacons.

3.3.
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Mobile beacon a.k.a. “hedgehog”
-

The mobile and stationary beacons can be
easily interchanged by selecting in the
Dashboard

-

The mobile beacons designed to be placed on
a robotic vehicle, copter/drone, AGV, or helmet
to trace its location. Formally speaking,
location of the mobile beacon is traced—not
the robot itself. Since the sizes and the location
of the central point of the mobile beacon and
the robot are different, the difference taken into
account in the robot’s software (SW)

-

It is recommended to place the mobile beacon
horizontally to provide optimal ultrasonic
coverage in the upper hemisphere

Fig.1: Super-Beacon as an example

-

Its sensors must not be covered with anything that can reduce the strength of
ultrasonic signal. For example, the system won’t normally work, if one puts the
mobile beacon in a plastic box

-

The beacon’s coordinates are updated according to the rate set on the Dashboard

-

The system may contain one or several mobile beacons. Current implementation
relies on a time-division multiple access approach. Thus, if two mobile beacons are
activated, they share the same system bandwidth. It means that, if the 16 Hz update
rate is selected in the Dashboard and there are 2 mobile beacons in the system,
each beacon’s location will be updated with the rate of 16Hz/2 ~ 8Hz. If there are 3
mobile beacons => 16Hz/3 ~ 5Hz, etc. For 4 and more mobile beacons we
recommend using Inverse Architecture. See more in Architectures comparison

-

Location data is obtained either from the “hedgehog” via USB (virtual UART), UART,
SPI, or from the modem/router via USB (virtual UART). More information on
interfaces can be found here (Mini-TX Beacons do not have pinouts, only over mirco
USB)

-

Data from the beacon sent in a streaming format identical to that of GPS (NMEA
0183)

-

There are 433MHz(out of production, get bug-fixing SW update only) and
868/915MHz versions available. Proprietary radio protocol is used for
communication and synchronization

-

The “hedgehog” has been successfully integrated with Windows PC, Linux
machines, Raspberry Pi, Arduino boards, Intel boards, etc.

3.4.
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Modem
-

Modem is the central controller of the system. It must always
be powered when the Navigation System is working. It is
recommended to use an active USB hub for that purpose or
even a regular cellular phone USB power supply. A USB
power bank can also be used

-

The modem is also used to set up the system, monitor it, and
interact with the Dashboard

-

It can be placed anywhere within radio coverage for
permanent radio connection with all beacons—usually in the
radius of up to 100 meters with antennas from the Starter Set

-

Radio coverage further extended to a few hundred meters by
using a lower bitrate of 38kbps and full-size (165mm for a 433
and 915MHz band) antennas, which have been tested to
provide up to 400m in ideal conditions

-

There are 433MHz (only for HW v4.9, out of production, get bug-fixing SW update
only) and 915MHz versions available

-

A proprietary radio protocol used for communication and synchronization between
modem and beacons

Fig.1: HW v5.1 Modem as
an example

3.5.

Different types of modems

There are 3 types of Marvelmind modems:
-

Modem HW v5.1 – newest and mostly use version of modem.

-

Modem HW v 4.9 – old version of Modem HW v5.1. out of production, get bugfixing SW update only

-

Super-Modem - is a superior version of the Modem HW v4.9 and Modem HW
v5.1 with advanced capabilities

3.5.1. Super-Modem
Super-Modem is a superior version of the Modem HW v4.9 and Modem HW v5.1 with
advanced capabilities.

Fig.2: Super-Modem’s contents of delivery
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-

Super-modem supports all the basic features of HW v4.9 Modem and can be
connected over USB to the Dashboard for system tuning and control (Do not forget
to power Super-Modem via Power connector)

-

UDP streaming over Wi-Fi is supported. In the future remote control of the modem
and the whole system via TCP-IP will be supported too

-

Bluetooth (HW enabled, but not yet supported in SW)

-

>1000x more RAM and >1000x Flash memory than Modem HW v4.9

-

Full-size bendable antenna by default

-

Higher ingress protection - up to IP67 (optional)

-

Super-Modem’s HW supports Super-Modem and Super-Super-Modem functionality
for
Multi-Modem
architecture:
https://marvelmind.com/pics/marvelmind_presentation.pdf

-

Designed for outdoor and industrial applications

-

External bendable antennas with SMA connector for extended radio range included
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-

Currently, supports license-free 915MHz ISM band (for example, US, Japan, Korea)
and license-free SRD band 868MHz (EU, Russia). Future 433MHz HW variants
may come in some months, but no firm schedule yet. You can place orders for
433MHz. When sufficient amount is collected, we will produce the 433MHz version
as well

-

Supports all types of beacons working in the 915MHz band (among them: SuperBeacons, all Industrial beacons, Mini-RX, Beacons HW v4.9, Helmets, Badges,
Jackets, Watches, etc.)

-

Two IP67 external connectors included (similar to Industrial beacons):

-

Exactly the same mounting holes as for Industrial beacons

-

No battery inside – external power supply (+6..17V) required (for example,
https://marvelmind.com/product/converter-220v-12v-ip67/). External battery is not
practical for long-term due to relatively high and constant power consumption of 1.52W

-

For optional IP67 version – extended working temperature range: -40C…+50C
(provided by design – not tested, not certified)

-

Embedded reset switch and DFU switch – magnetic control or external pins on IP67

-

Supports both IA and NIA. Can be easily switched between the modes in the
Dashboard

-

Radio range to beacons – up to a few hundred meters in the open space area. WiFi – a few tens of meters in the open space

3.5.2. Modem HW v5.1
Modem HW v5.1 is a superior version of the Modem HW v4.9.
Modem HW v5.1 looks almost the same as Modem HW v4.9. To
distinguish it, check white sticker on the bottom
Modem HW v5.1 and Modem HW v4.9 brief comparison:

-

Modem HW v5.1 has more memory

-

Modem HW v5.1 has higher radio range

-

Modem HW v5.1 more sensitive

-

Modem HW v5.1 has TELEC T-108 Japan certification

-

All new features come to the new Modem HW v5.1

Fig.1: Modem HW v5.1

-

Fig.2: Bottom sticker

-

FCC NOTICE:

This equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a residential installation. This
equipment generates, uses and can radiate radio frequency energy and, if not installed
and used in accordance with the instructions, may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a
particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the
user is encouraged to try to correct the interference by one or more of the following
measures:
Reorient or relocate the receiving antenna
Increase the separation between the equipment and receiver
Connect the equipment into an outlet on a circuit different from that to which the receiver
is connected
Consult the dealer or an experienced radio/TV technician for help
Changes or modiﬁcations not expressly approved by the party responsible for compliance
could void the user's authority to operate the equipment.
This device complies with part 15 of the FCC Rules. Operation is subject to the following
two conditions:
(1)

This device may not cause harmful interference, and

(2)
This device must accept any interference received, including interference that
may cause undesired operation.
The equipment should be installed and operated with minimum distance 20cm between
the radiator & your body.
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3.5.3. Modem HW v4.9
Modem HW v4.9 has balanced features and performance.
Since Modem HW v5.1 released, Modem HW v4.9 will get bug-fixing SW
updates only
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-

The modem is also used to set up the system, monitor it, and
interact with the Dashboard

-

It can be placed anywhere within radio coverage for
permanent radio connection with all beacons—usually in the
radius of up to 100 meters with antennas from the Starter Set

-

Radio coverage further extended to a few hundred meters by
Fig.1: Modem HW v4.9
using a lower bitrate of 38kbps and full-size (165mm for a
433MHz band) antennas, which have been tested to provide up to 400m in ideal
conditions

-

There are 433MHz and 915MHz versions available

-

A proprietary radio protocol used for communication and synchronization between
modem and beacons

3.6.

Different types of beacons
There are many types of beacons. Each of them is using in different ways, depends on
your case and preferences.
There is small Beacon Mini-RX that can receive ultrasound and mostly using as mobile
beacon.
Compact beacon Mini-TX – for ultrasound transmitting only. This is good for copter and
tracking for its small size.
Super-Beacon – can receive and transmit ultrasound, using in most cases. Could be
made in Outdoor modification.
Industrial Beacons – suitable for huge manufacturing and outdoor installations.
Here you can see more details about the different types of beacons:
https://marvelmind.com/pics/marvelmind_beacons_comparison.pdf
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3.6.1. Super-Beacon
The Super-Beacon is a dual-use beacon – it can both receive
and transmit ultrasonic pulses.
The Super-Beacon Beacon can be used in both the NonInverse Architecture (NIA) and the Inverse Architecture (IA):
Architecture comparison.
Supports license-free 915MHz ISM band (US) and licensefree SRD band 868MHz (EU). Support of the 433MHz ISM
band (EU) comes with a larger order.
Key features:

-

The Super-Beacon has a separate receiving part with
a single wide-beam microphone and sharp DSP
filters (like Mini-RX or Industrial-RX has). Thus, it is more sensitive, than Beacon
HW v4.9, more resistant to external noise, and easier to setup, because you don’t
have to care about turning on and off ultrasonic sensors in order to optimize
coverage vs. sensitivity

-

The Super-Beacon can receive any ultrasonic frequency from the bands: 19kHz,
22kHz, 25kHz, 28kHz, 31kHz, 34kHz, 37kHz, 45kHz. The filter can be simply
selected in the Dashboard. At the same time, the ultrasonic frequency of Beacon
HW v4.9 is HW-defined by ultrasonic sensors and can’t be changed

-

The Super-Beacon can receive several ultrasonic frequencies at once. That is used
in the Inverse Architecture. See the comparison

-

The Super-Beacon has several-times improved battery lifetime in TX mode as
compared with Beacon HW v4.9

-

The Super-Beacon can work with regular Beacons HW v4.9 and Mini-RX and
Industrial-RX in any combination as a part of a Starter Set or as a part of navigation
systems. In all cases, beacons shall use the same radio band

Super-Beacon also has outdoor (IP54) version, which is protected from dust and water
Demo video: Demo: IP56 testing of Super-Beacon-IPxx

Figure 1: Outdoor version (IP54)
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Figure 2: Transmitting diagram (with
ultrasound transmitters)

Figure 4: Receiving diagram (with digital
microphone)

Figure 3: Transmitting diagram (with
ultrasound transmitters)

Figure 5: Receiving diagram (with digital
microphone)

FCC NOTICE:
This equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a residential installation. This
equipment generates, uses and can radiate radio frequency energy and, if not installed
and used in accordance with the instructions, may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a
particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the
user is encouraged to try to correct the interference by one or more of the following
measures:

-

Reorient or relocate the receiving antenna

-

Increase the separation between the equipment and receiver

-

Connect the equipment into an outlet on a circuit different from that to which the
receiver is connected

-

Consult the dealer or an experienced radio/TV technician for help

Changes or modiﬁcations not expressly approved by the party responsible for compliance
could void the user's authority to operate the equipment.
This device complies with part 15 of the FCC Rules. Operation is subject to the following
two conditions:
(1)

This device may not cause harmful interference, and

(2)
This device must accept any interference received, including interference that
may cause undesired operation.
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The equipment should be installed and operated with minimum distance 20cm between
the radiator & your body.
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3.6.1.1. Omni and External microphones extension
This modification of the Super-Beacon allows you to bring the receiving microphone
to any place on your robot or clothing. Due to this, the microphone body itself will not
interfere, and will not be visible. It allows you to create more accurate implantation.
It is possible to connect External Microphone-IP67 or Omni-Microphone-IP67
It is also possible to use 2 External Microphones to calculate the direction, or to
improve and increase the reception area.
Omni-Microphone-IP67 wire length is 1m, it connects to 4x4 pinout in default
configuration.
External microphone length is 25cm (default), may be expanded up to 1m (optional).
Check out the product page.
Be careful: You should have soldering skills to solder External Microphone on
board

Figure 1: Super-Beacon with one External Microphone connected
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Figure 2: Super-Beacon with two External Microphones connected

Figure 3: Super-Beacon with Omni
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3.6.1.2. Omni microphone schemes
If you don’t want to use 4x4 pinout to connect Omni, use this scheme to solder it.
Be careful: You should have soldering skills to solder Omni Microphone on board

Figure 4: Omni-Microphone connection for Super-Beacon

Figure 5: Omni-Microphone connection for Super-Beacon-2 and Super-Beacon-3

37

3.6.1.3. External microphones schemes:
There can be some beacons (from one of the batches) with mixed default
microphone wires’ colors

Figure 6: Connection for beacon with switched blue and yellow wires
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Figure 7: One External Microphone connection

Figure 8: Two External Microphone connection
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3.6.2. Beacon Mini-RX
The Beacon Mini-RX can be used in both the Non-Inverse
Architecture (NIA) and in the Inverse Architecture (IA): NIA and
IA comparison
The Mini-RX beacon HW differs from the regular Beacon HW
v4.9 in several ways:

-

It is an RX-only beacon, i.e. it can receive, but it cannot
transmit ultrasonic signal

-

The fact that it is RX-only makes it far more sensitive, i.e. you will get a longer range
between Beacon HW 4.9 and Mini-RX than between Beacon HW 4.9 and Beacon
HW 4.9.

-

Mini-RX beacon can receive any ultrasonic frequency from the bands: 19kHz,
22kHz, 25kHz, 28kHz, 31kHz, 34kHz, 37kHz, 45kHz. The filter can be simply
selected in the Dashboard. At the same time, the working ultrasonic frequency of
Beacon HW v4.9 is HW-defined by ultrasonic sensors and can’t be changed

-

Mini-RX beacon can receive several ultrasonic frequencies at once. That is used in
Inverse Architecture. See the comparison: NIA and IA comparison

-

The Mini-RX Beacon is significantly smaller than Super-Beacon

-

Can play a role of stationary beacon when imputing coordinates manually (in NIA)

-

Can play a role of mobile beacon (in IA system)

-

Has digital microphone, which is more sensitive than regular sensors

-

Supports 868/915MHz radio only

-

Light weighted

-

Can be water-protected

-

The component of the Marvelmind Helmet and Marvelmind Watch

-

It has 360° reception angle (horizontally) and 180° reception angle (vertically)

Reception diagram. Digital microphone has about 360° (horizontally) and 180°
(vertically) reception angle

Mini-RX beacon may be over discharged. In that case do the following:
Turn off the beacon with DIP switches and charge it for 1 hour. Then turn the
beacon on, flash the latest SW via DFU Programming and charge it for 1 hour
again
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3.6.2.1. How to flash Beacon Mini-RX
When you receive Beacon Mini-RX, it is turned off. Open it, to get access to DIP
switch.

Put DIP switch to needed position:

-

When DIP switch in this position – only charge of device is possible.

Put DIP switch to this position:

-

To turn on the beacon

-

For HEX programming (via Dashboard)

Put DIP switch to this position:

-
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For DFU programing (via: DfuSe v3.0.5 or DfuSe v3.0.6)

3.6.2.2. External microphone extension for Mini-RX
This modification of the Mini-RX beacon allows you to bring the receiving microphone
to any place on the robot or clothing. Due to this, the microphone body itself will not
interfere, and will not be visible. It allows you to create more accurate implantation.
It is also possible to use 2 external microphones to calculate the direction, or to
improve and increase the reception area.
Length is 25cm (default), may be expanded up to 1m (optional). Check out the
product page.
Be careful: You should have soldering skills to solder external microphone on board

Mini-RX beacon

External Microphone
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3.6.2.3. Dual microphones modification:
External Microphone 1

Robot’s head
Mini-RX beacon hidden
inside

47mm
210mm

Figure 1: One external microphone with housing

Figure 2: Two external microphones with housing
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External Microphone 2

Figure 3: One external microphone soldering

Figure 4: Two external microphones soldering
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3.6.2.4. External microphones schemes:

Figure 5: One External Microphone connection

Figure 6: Two External Microphones connection
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Figure 7: Two External Microphones final view

Figure 8: Two External Microphones final view
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3.6.3. Beacon Mini-TX
The Mini-TX is a TX only beacon, i.e. it can transmit, but cannot
receive ultrasound.
Comparison to Beacon HW v4.9:
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-

Smaller size and lighter: 47x42x15mm & 25g vs.
55x55x33mm & 62g (or 55x55x64mm with antenna)

-

TX only, i.e. Mini-TX can only transmit ultrasonic and
cannot receive. Beacon HW v4.9 is dual use: can receive and transmit ultrasonic

-

Battery – 250mAh vs. 1000mAh in a regular beacon. But Mini-TX has a new more
efficient ultrasonic TX module, thus, battery lifetime in TX mode is even superior to
the Beacon HW v4.9

-

Tested battery lifetime with 8Hz – 96h. With lower update rate – nearly
proportionally longer. Very efficient ultrasonic TX module

-

Mini-TX has only USB (virtual UART) output – no additional pins

-

Mini-TXs always have embedded IMU – newer and better, but it has 3D
accelerometer and 3D gyroscope, but no magnetometer (which we do not
recommend using indoors anyway, due to magnetic field distortion indoor)

-

Embedded antenna – smaller size, but smaller radio coverage ~50m with regular
Modem HW v4.9 as compared with ~100m of Beacon HW v4.9 with Modem HW
v4.9

-

Range in ultrasonic is virtually on par with regular Beacon HW v4.9 – up to 30m with
Beacon HW v4.9 as RX beacon. At the same time, for example, a combination of
Mini-RX RX beacon + Mini-TX TX provide a better coverage and a stronger signal,
than Beacon HW v4.9 + Beacon HW v4.9

-

This HW is for the 868/915MHz band only, i.e. 433MHz is not supported and not
planned

3.6.4. Beacon Industrial-TX-Metal
Do not disassemble the Industrial beacons. Otherwise, warranty will be lost

-

TX-only beacon – can
ultrasonic, but can’t receive it

-

Electronics is IP67 protected

-

Special
IP67-protected
transducers

-

External antenna with SMA connector for
extended radio range

-

Corresponding IP67 connectors (male
part) included

-

No battery inside

-

Extended working temperature range
from -40°C to +50°C (not tested,
provided by design)

-

Embedded reset switch and DFU switch – magnetic control

-

Two IP67 external connectors:

-

Modification (After June 2022) for versions 2 and 3

transmit

25kHz

+5V in (3)
+5V in (5)

-

Version 2 and 3 of Industrial-TX-Metal (from June 2022) supports ONLY +5V power
supply. Don’t use +12V power supply converter for this version, it will burn the beacon!

This version doesn’t have UART RX, but now is possible to use Interface connector as a
power supply.
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-

RS485 modification pinouts (After Sep.2019)

-

RS485 modification pinouts (Before Sep.2019)

-

CAN modification pinouts

-

Can work with any Mini-RX beacon or Beacon HW v4.9 with 25kHz ultrasonic
sensors (radio bands must match)

-

Most of all designed to work together with Outdoor versions of Mini-RX beacons
and heavy outdoor Industrial-TX and Industrial-RX beacons (radio bands must
match)

-

Up to 30m with Beacon Mini-RX

-

Optional external Converter-220V-12V-IP67 (except version from April 2022, it
supports only +5V power supply)

-

Wide transmitting diagram

Determine carefully the version of your Industrial beacons: it may
be built before September 2019 and after September 2019. If it is
beacon from the late batch, you must use Industrial Super-beacon
SW. if you have beacons from the early batch, use Industrial-RX or
Industrial-TX SW. Stickers’ differences: Later batch – Ind-RX-S or
Ind-TX-S. Early batch – Beacon Ind-RX or Beacon Ind-TX.

Version 2 and 3 of Industrial-TX-Metal (from June 2022) supports ONLY +5V
power supply. Don’t use +12V power supply converter for this version, it will burn
the beacon!
This version doesn’t have UART RX, but now is possible to use Interface connector
as a power supply.

49

3.6.5. Beacon Industrial-RX
Do not disassemble the Industrial beacons. Otherwise, warranty will be lost

-

RX-only beacon – can receive
ultrasonic, but can’t transmit it

-

Electronics is IP67 protected

-

Special IP67-membrane for ultrasonic
sensor

-

External antenna with SMA connector
for extended radio range

-

Corresponding IP67 connectors (male
part) included

-

No battery inside by default – external
power bank or external power supply (+12V or +5V). But, optional variant with
internal battery is possible (except version from April 2022, it supports only +5V
power supply)

-

Two IP67 external connectors:

-

Modification (After April 2022)

+5V in (3)
+5V in (5)

Version 3 of Industrial RX (from April 2022) supports ONLY +5V power supply.
Don’t use +12V power supply converter for this version, it will burn the beacon!
This version doesn’t have UART RX, but now is possible to use Interface connector
as a power supply.

-
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RS485 modification pinouts (After Sep.2019)

51

-

RS485 modification pinouts (Before Sep.2019)

-

CAN modification pinouts

-

Extended working temperature range from -40°C to +50°C (not tested, provided by
design) – only for the version without battery

-

Embedded reset switch and DFU switch – magnetic control

-

Supports wide range of ultrasonic frequencies: 19/22/25/28/31/34/37/45kHz

-

Most of all designed to work together with Outdoor versions of Mini-RX beacons
and heavy outdoor Industrial-TX and Industrial-RX beacons (radio bands must
match)

-

Optional external Converter-220V-12V-IP67 (except version from April 2022, it
supports only +5V power supply)

-

Wide reception diagram

Uploading Beacon’s Industrial-RX or Beacon’s Industrial-TX SW to Industrial
Super-beacon may permanently damage Industrial Super-beacon board.
Determine carefully the version of your Industrial beacons: it may
be built before September 2019 and after September 2019. If it
is beacon from the late batch, you must use Industrial Superbeacon SW. if you have beacons from the early batch, use
Industrial-RX or Industrial-TX SW. Stickers’ differences: Later
batch – Ind-RX-S or Ind-TX-S. Early batch – Beacon Ind-RX or
Beacon Ind-TX.

Version 2 and 3 of Industrial-TX-Metal (from June 2022)
supports ONLY +5V power supply. Don’t use +12V power
supply converter for this version, it will burn the beacon!
This version doesn’t have UART RX, but now is possible to use
Interface connector as a power supply.
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3.6.6. Industrial Super-Beacon Metal-25kHz
Do not disassemble the Industrial beacons. Otherwise, warranty will be lost

-

Supports dual-use – RX and TX beacon.
It can transmit on its native ultrasonic
frequency (25kHz) and it can receive on
any ultrasonic frequency via an
embedded RX sensor – like IndustrialRX or Mini-RX does. Effectively, the
Industrial Super-Beacons beacons
combines inside an Industrial-TX and
Industrial-RX. Additionally, the beacon
supports both AI and NIA architectures.
Thus, it is called Industrial SuperBeacon

-

Electronics is IP67 protected

-

Special IP67-protected 25-kHz transducers

-

External antenna with SMA connector for extended radio range

-

Corresponding IP67 connectors (male part) included

-

No battery inside

-

Extended working temperature range from -40°C to +50°C (not tested, provided by
design)

-

Embedded reset switch and DFU switch – magnetic control

-

Two IP67 external connectors:

-

Modification (After April 2022)

+5V in (3)
+5V in (5)
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-

Version 3 of Industrial RX (from April 2022) supports ONLY +5V power supply. Don’t
use +12V power supply converter for this version, it will burn the beacon!

-

This version doesn’t have UART RX, but now is possible to use Interface connector as a
power supply.

-

RS485 modification pinouts

-

Can work together with modems with corresponding radio (radio bands must match)

-

Can work with any Mini-RX beacon or Beacon HW v4.9 with 25kHz ultrasonic
sensors (radio bands must match)

-

Most of all designed to work together with Outdoor versions of Mini-RX beacons
and heavy outdoor Industrial-TX and Industrial-RX beacons (radio bands must
match)

-

Up to 30m with Beacon Mini-RX

-

Optional external Converter-220V-12V-IP67 (except version from April 2022, it
supports only +5V power supply)
Uploading Beacon Industrial’s (Not super) DFU software to Industrial SuperBeacon hardware make permanently damage for Industrial Super-Beacon board.
Be double attentive with update
Version 2 and 3 of Industrial-TX-Metal (from June 2022) supports ONLY +5V
power supply. Don’t use +12V power supply converter for this version, it will burn
the beacon!
This version doesn’t have UART RX, but now is possible to use Interface connector
as a power supply.
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3.6.7. Beacon HW v4.9
Beacon HW v4.9 can be used in both the Non-Inverse Architecture (NIA)
and in the Inverse Architecture (IA): NIA and IA comparison
Reception diagram. Each sensor has about 90° reception angle:

Figure 1: Transmitting diagram (with sensors)

Figure 2: Transmitting diagram (with sensors)
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4. Software pack
In this chapter you can find out how to use our SW pack.
Always remember:
-

All devices must be flashed from the same SW Pack
Don’t look on the dates in the name of file, they can be different, pay attention
only to the name of the device.
If the device was flashed with an older firmware version then Dashboard, this
will be displayed in the diagnostic message window:

Changes in files in the Marvelmind SW pack (from SW version 7.200):
The SW files for beacons/modems that don’t require an update with the new release
won’t be replaced with the new files in the new SW pack. However, the Dashboard will
assign the new version number to them based on the newly introduced a SW version
compatibility table. Thus, the files physically remain the same, but, if they are compatible
with the latest SW pack, the Dashboard will automatically substitute their older SW
version number with the latest SW version number
It is done in order to detect and avoid the most common mistake by the users – an
attempt to run incompatible SW versions of beacons, modem, Dashboard obtained from
different SW packs, i.e. not updating the beacons/modems to the latest SW version from
the same SW pack upon getting the equipment from Marvelmind Robotics

Changes in naming of SW versions and licenses (from SW version 7.200):
Optional SW feature brought by MMSW0005 are now marked with L at the end of the
release name. For example, v7.200 – only base SW features are enabled – by default.
Purchasing the MMSW0005 license activates optional features and the SW version
changes to v7.200L
Naming example IA vs. NIA: v7.200 and v7.200L – SW for NIA and MF NIA, v7.200i
and v7.200Li – SW for IA
If some beacons/modems don’t have the MMSW0005 license, their addresses are listed
in the upper part of the Dashboard – information window
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4.1.

Download and open
4.1.1.Go to our web-site https://marvelmind.com/ =>
https://marvelmind.com/download/ and download the latest Marvelmind SW
pack

4.1.2.Unzip pack and open a folder

Folder with Marvelmind API library and C
example
Folder with Dashboard software

Folder with documentation

Folder with misc sample code

Folder with software for modem and beacons
for inverse architecture (IA)
Folder with software for modem and beacons
for non-inverse architecture (NIA)
Folder with software for Super-Modem (same
software for both NIA and IA).
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4.2.

Dashboard folder
In this folder you can find all modifications of Dashboard.

Folder with Dashboard for Linux

Folder with Dashboard for Windows
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4.3.

Software IA folder
In this folder you can find all software to flash devices to build a map in Inverse
Architecture. Use this folder to flash sets:
1) Starter Set IA-04-2D-Badge
2) Starter Set Super-MP-3D in Inverse Architecture

For Badge:

For Beacon HW 4.9 in IA:

For Beacon Mini-RX:

For Cap

For Headlight (IA)
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For Helmet

For Industrial Super-Beacons* (watch the
next page to learn more about IndustrialBeacons types)
For Jacket (IA)

For Modem HW v4.9:

For Modem HW v5.1:

For Super-Beacon (IA):

For Watch
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4.3.1. Types of Industrial-Super-Beacons:
1) Beacon Industrial-RX:

2) Industrial Super-Beacon Metal-25kHz:

3) Industrial Super-Beacon-Plastic:
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4.4.

Software NIA folder
In this folder you can find all software to flash devices to build a map in Non-Inverse
Architecture. Use this folder to flash sets:
1) Starter Set HW v4.9-NIA:

2) Starter Set NIA-SmallDrone:

3) Starter Set Industrial-NIA-01:

4) Starter Set Super-MP-3D in NIA:

62

For Beacon HW 4.5

For Beacon HW 4.9 433 and 915 NIA:

For Beacon Mini-RX:

For Beacon Mini-TX:

For Industrial Beacons:

For Modem HW v4.9:

For Modem HW v5.1:

For Super-Beacon (NIA):
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4.5.

Super-Modem folder
Folder with Super-Modem software (same software for both NIA and IA).
Warning! If your current Super-Modem software version is less than 7.000, you need to
reflash micro-SD card inside the Super-Modem for update. Super-Modem Micro-SD card
image is supplied in separate archive, because it is pretty large.
After SW release v7.040 you can flash Super-Modem via Dashboard. Flash both levels –
high and low.
Please refer to downloads page and download SW for Super-Modem

Firmware for Super-Modem high level

DFU and HEX files for Super-Modem flash. Low
level
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5. SW settings descriptions
5.1.

Super-Modem’s SW update and configuration description
5.1.1. Super-Modem’s SW update
Do not disassemble the Super-Modem before you check the SW version installed. First of all,
check if the SW version of your Super-Modem is up to date (Latest version on the Marvelmind
Downloads page). If not – update the software as described below
Marvelmind Super-Modem software consists of two parts:

-

Low level firmware

-

High level software for integrated Raspberry Pi single-board computer

Low level firmware is placed in general software package with all Marvelmind software in
‘Super-Modem’ folder. This firmware can be updated via dashboard (hex file) or via DFU
(dfu file) like other firmware in the package. Please refer to Operating Manual for details of
updating software via dashboard or dfu.
High level software is located on micro-SD card inserted in the Raspberry Pi single-board
computer inside Super-Modem. To update this software, you should write on this micro-SD
card the image of micro-SD card with updated software. You can download the image on
downloads page (https://marvelmind.com/download/). The image is placed in archive
separately from general software package because its size is pretty large (archive is about
1.5 - 2 GB).
Micro-SD card location
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5.1.2. How to update Super-Modem (for SW version from v7.000)
In latest versions of SW it’s possible to flash Super-Modem without dissembling.
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5.1.2.1.

Connect power Supply to Super-Modem and connect Super-Modem to
PC via USB. Wait for 1 minute till it appears in Dashboard

5.1.2.2.

There are two Firmware versions – Low level (Firmware version) and
High level (High level software version). Both of them should be flashed
from the same pack.

5.1.2.3.

Go to Firmware => Upload firmware
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5.1.2.4.

Update high level SW (from folder Super-Modem_high_level SW)

5.1.2.5.

When high level flashing done, use file from folder SuperModem_low_level_SW

5.1.2.6.

Press Default button after flashing of both levels.

5.1.2.7.

Firmware update successfully completed.

5.1.3. How to update Super-Modem’s SW (for SW version older
than v7.000):
Do not disassemble the Super-Modem before you check the SW version installed. First of all,
check if the SW version of your Super-Modem is up to date (Latest version on the Marvelmind
Downloads page). If not – update the software as described below
Follow the steps below to update Super-Modem’s SW.
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5.1.3.1.

Open Super-Modem enclosure

5.1.3.2.

Eject the micro-SD card (Super-Modem should not be powered at this
time)

5.1.3.3.

Insert micro-SD card into any MS Windows computer via card reader

5.1.3.4.

Download and unpack the archive with image of updated software

5.1.3.5.

Install and run Win32 disk imager program (supplied in the archive with
image)

5.1.3.6.

Open the image file and write to the micro-SD card (see screenshot
below)

5.1.3.7.

Eject micro-SD card from computer and insert back into Super-Modem

5.1.3.8.

Close Super-Modem enclosure

5.1.4. Super-Modem’s configuration
Do not disassemble the Super-Modem before you check the SW version installed. First of all,
check if the SW version of your Super-Modem is up to date (Latest version on the Marvelmind
Downloads page). If not – update the software as described below
Marvelmind Super-Modem contains Raspberry Pi single-board computer with
corresponding software. Some settings can be modified via configuration files on the
micro-SD card inserted in the Super-Modem.
To modify these files, you need to:

-

Open Super-Modem enclosure

-

Eject the micro-SD card (Super-Modem should not be powered at this time),

-

Insert micro-SD card into any computer with Linux

-

Open and modify certain configuration files on the micro-SD card (see below)

-

Eject micro-SD card from computer and insert back into Super-Modem

-

Close Super-Modem enclosure

Micro-SD card location

When you insert it into computer with Linux, required files are usually located by following
path:
/media/<user name>/rootfs/home/pi/supermodem:
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5.1.4.1.

Super-Modem’s settings descriptions

In file “network_options”:

-

wifi_network – name (SSID) of WiFi network to connect

-

wifi_password – password (PSK) for this network

In file “stream_options”:

-

udp_destination_ip – IP address in local network where Super-Modem will
stream data

-

udp_destination_port – UDP port where Super-Modem will stream data

If you need more information about UDP streaming here https://marvelmind.com/pics/UDP_C_example.zip
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5.2.

SW update (USB/Radio/DFU)

This chapter describes three general ways of SW update. Regular - using USB
connection, or Radio connection. And SW update for special cases (if SW version gap
is very big, or regular SW update do not work) – DFU Programming.

5.2.1. SW update via USB
Usually, SW update via USB is used for the very first time you starting up the system. It
allows you to make an update up to actual SW version very quickly before the system
deployment.
Pros: Quick SW update per beacon.
Cons: All the devices should be connected to the PC via USB cable. If you already
deployed the system, you will need to unmount it.
How to:
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-

Launch the Dashboard

-

Make sure that the beacon is on

-

Connect beacon to your PC via USB cable

-

When beacon connected to the Dashboard, go to “Firmware” → “Upload firmware”

-

Choose .hex SW file for your device (Be careful with IA and NIA architectures, do
not mix it)

-

Click “Next”

-

Wait until beacon update finishes

Note: Press Default button for every beacon after SW update

-

Repeat for all your beacons

Be careful: Default button will apply full default settings to this beacon, except it’s
address. If you had some custom Radio settings before, it would be changed to
153kbps Radio profile, 0 Radio channel
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5.2.2. SW update via Radio
Usually, SW update via USB is used for the very first time you are starting up the system.
It allows you to make an update up to actual SW version very quickly before system
deployment.
Pros: Allows you to keep your system in its place and update SW remotely
Cons: Not as fast as USB SW update
How to:

-

Launch the Dashboard

-

Make sure that the modem is connected to the Dashboard (via USB)

-

Ensure that you can see your beacons via radio in the Dashboard

-

Click on the beacon you want to update (In the bottom devices’ list)

-

go to “Firmware” → “Upload firmware” → Choose .hex SW file for your device
(Be careful with IA and NIA architectures, do not mix them)

-

Click “Next”

-

Wait until beacon update finishes

-

Repeat for all your beacons
-

73

Note: with additional license you can enable simultaneous update of multiple
beacons (stationary and mobile)

5.2.3. SW update via DFU Programming
Not applicable to “Outdoor” versions of originally non-outdoor versions
Usually, SW update happen using regular USB or Radio SW update. But in case when you
didn’t update your system for a long time (and get a big SW version gap), or you faced with
some unexpectable troubles – please do the DFU Programming SW update. This chapter
describes DFU update for different types of devices.
Pros: Ultimatum SW update – erases all glitches, settings and etc. Makes it possible to
revive beacon if “everything goes bad”
Cons: More complicated than a regular SW update, clears all settings – Save map file
not to lose your map
To make a DFU Programming, you need to know where hardware reset button and DIP
switches are placed.
Reset button and DIP switch placement for non-industrial beacons:

-

Super-Beacon:

Reset button

DIP switches

-

HW v4.9 Beacon:

Reset button (on side)

DIP switches

-

Mini-RX beacon:

Reset button

Disassemble

Carefully
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DIP switches

-

Mini-TX beacon:

Disassemble

Reset button (on the other side)
DIP switches

Carefully

Industrial beacons have no switches and reset buttons, but they have magnetic DFU
switch and magnetic Reset button:

-

Industrial Super-Beacon-Plastic:

Magnetic Reset side

-

Industrial Super-Beacon Metal-25kHz:

Magnetic Reset side
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Magnetic DFU switch side

Magnetic DFU switch side

-

Beacon Industrial-RX:

Magnetic Reset side

Magnetic DFU switch side

How to enter into DFU mode and Reset different types of Modems:

-

Modem HW v5.1:
Hardware Reset button (on side)
DFU mode pins

-

Modem HW v4.9:
Hardware Reset button (on side)
DFU mode pins

-

Super-Modem:

Magnetic Reset side
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Magnetic DFU switch side

DFU Programming process:
1.
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Enter device into DFU Mode:

-

For regular and non-Industrial versions of beacons – switch DIP
switches into positions shown on the picture (both up) and press the
Reset button – device will go into DFU mode

-

For Industrial versions of beacon and Super-Modem – attach one
magnet to the DFU switch side, and attach for 1 second the second
magnet to the Reset side of the device – device will go into DFU mode
(Do not forget to power Industrial versions of beacon and SuperModem – they do not have internal battery)

-

For Modem HW v5.1 and Modem HW v4.9 – short DFU mode pins and
press the Reset button – device will go into DFU mode

2.

Connect the device via USB to your PC (Do not forget to power Industrial
versions of beacon and Super-Modem – they do not have internal battery).

3.

Run DfuSe (Choose whichever works the best for your Windows: DfuSe
v3.0.4 or DfuSe v.3.0.5.

4.

In the upper left corner of the DfuSe program, you will see a device connected
in the DFU mode (If not – reenter device into DFU mode).

5.

Choose the DFU driver (file) for the beacon.

6.

Click the UPGRADE button.

7.

After a couple of seconds, the DFU will be uploaded to the beacon. Make
sure it takes 1–3 seconds and does not happen instantly. Otherwise, the SW
has not been uploaded correctly. If the DFU appears to upload immediately,
check the "Choose" button you used or change the version of DfuSe SW you
selected.

8.
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Exit from the DFU mode:

-

For regular and non-Industrial versions of beacons – switch DIP
switches into positions shown on the picture (Left – down, right – up)
and press the Reset button – device will exit from DFU mode

-

For Industrial versions of beacon and Super-Modem – remove one
from the DFU switch side, and attach for 1 second the second magnet
to the Reset side of the device – device will exit from DFU mode

-

For Modem HW v5.1 and Modem HW v4.9 – shot circuit DFU mode
pins and press the Reset button – device will go into DFU mode

9.

Start the Dashboard, left device connected to the PC via USB (Do not forget
to power Industrial versions of beacon and Super-Modem – they do not have
internal battery), device should appear in the Dashboard.

10.

Check SW on the beacon afterwards.

11.

Everything should be OK with SW now. DFU programming is complete.

6. Setting up the system
6.1.

Introduction

Our system supports Non-Inverse Architecture and Inverse Architecture. But we
strongly recommend to start from NIA in 2D configuration (2 stationary beacons and 1
mobile beacon). As you achieved perfect results in NIA, you can set up the system in
IA.
Check:
8 basic steps from unpacking to autonomous drive/flight
Step-by-step guide on how to build complex maps
Detailed explanation of complex map building:
Building submaps: Part 1
Building submaps: Part 2
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6.2.

DIP switch positions

This chapter shows different DIP switchers positions of devices on the example of a
Super-Beacon.

6.2.1. DIP switch position for OFF beacon
When DIP switch in this position – only charge of device is possible.

Reset button

DIP switches

6.2.2. DIP switch position for work and HEX programming
Put DIP switch to this position:

-

To turn on the beacon

-

For HEX programming (via Dashboard)

Reset button

DIP switches

6.2.3. DIP switch position for DFU programming
Put DIP switch to this position:

-

For DFU programing (via: DfuSe v3.0.5 or DfuSe v3.0.6)

Reset button

DIP switches

Put DIP switch to position for work and restart beacon after DFU programming.
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6.3.

Starter Set Super-MP-3D (NIA and IA)
The steps below describe the very first time you set up the system in NIA.
Super-Beacons and Modem HW v5.1 required.

This Set can bused in IA and NIA. Use NIA Software for Non-Inverse Architecture and
IA Software for Inverse Architecture.

6.3.1.Unpack the system. Look at a similar unpacking video of HW v4.9. The
videos have certain differences but the basic are the same: Unpacking
Marvelmind Precise (+-2cm) Indoor "GPS"
6.3.2.Charge all the beacons using USB cable. Full charging takes about 1-2 hours
6.3.3.Turn the beacons on: Place DIP switches as shown on the picture below
Reset button

DIP switches

6.3.4.Download SW Pack
6.3.5.Update all the beacons (HEX programming):
6.3.6.Run the Dashboard and update the SW for all beacons and modem using
Dashboard => Firmware => Choose the file => Program
6.3.7.If you see the message “Not found modem connection to computer through
USB” in the Dashboard or your PC does not recognize beacons/modem, it
usually means that the STM32 driver is not installed. To install the driver,
download it with link at top window in the Dashboard and run the installation
file, then click on the link under and install the driver
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6.3.8.Ensure that:
6.3.9.You are programming the modem’s SW to the modem and the beacon’s SW
to the beacon
6.3.10. You are using SW for Super-beacon, if you have Super-beacon; and you
have the SW from the same SW pack, i.e., the Dashboard SW, modem SW,
and beacon SW must be from the same SW pack. Don’t mix SW releases
6.3.11. If SW flashed SUCCESSFULLY, MOVE DIRECTLY TO 6.3.13. If you
have some problems with HEX programming, use DFU programming:
6.3.11.1.

DFU programming or SW uploading is used when HEX SW uploading
in the Dashboard cannot be used. For example, when you are updating
from a very old SW version or when the SW includes major changes to
the system and the only possible way to update the SW is via DFU
programming

6.3.11.2.

After the DFU SW upgrade, future SW upgrades can be done in a
regular manner via the Dashboard

6.3.11.3.

To start programming, move the beacon’s DIP switch to the DFU
programming mode, as described in the paragraph on DIP switch
modes

6.3.11.4.

Download the latest SW package, unzip it, and select the proper
version of the SW for your HW and for your frequency variant.
Remember that for DFU programming, you should use DFU SW
(DfuSe), not Dashboard’s .hex file

6.3.11.5.

Download DfuSe

6.3.11.6.

Here you will find different versions of DfuSe. v3.0.5 or v3.0.6,
whichever works the best for your Windows: DfuSe v3.0.5 or DfuSe
v3.0.6

6.3.11.7.

DFU Programming:

6.3.11.8.

Put DIP switch into Power = ON, DFU = ON

6.3.11.9.

Connect the beacon via USB to your PC

6.3.11.10. Run DfuSe
6.3.11.11. Press the RESET button on your beacon
6.3.11.12. In the upper left corner of the DfuSe program, you will see a device
connected in the DFU mode
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6.3.11.13. Choose the DFU driver (file) for the beacon

6.3.11.14. Click the UPGRADE button
6.3.11.15. After a couple of seconds, the DFU will be uploaded to the beacon.
Make sure it takes 1–3 seconds and does not happen instantly.
Otherwise, the SW has not been uploaded correctly. If the DFU appears
to upload immediately, check the "Choose" button you used or change
the version of DfuSe SW you selected
6.3.11.16. Move the DIP switch into Power = ON, DFU = OFF
6.3.11.17. Start the Dashboard and press the RESET button on the beacon
6.3.11.18. Check SW on the beacon afterwards
6.3.11.19. Everything should be OK with SW now. DFU programming is complete
6.3.11.20. Follow the same scenario for the modem:
6.3.11.21. After uploading DFU driver by DfuSe short circuit pins as shown on the
picture (for v4.9) and press Reset button

6.3.11.22. Modem will go to DFU mode. Press UPGRADE button in the DfuSe
program
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6.3.11.23. After a couple of seconds, the DFU will be uploaded to the modem.
Make sure it takes 1-3 seconds and does not happen immediately.
Otherwise, the SW has not been uploaded correctly. If the DFU appears
to upload immediately, check the "Choose" button you used or change
the version of DfuSe SW to a different one
6.3.11.24. Disconnect the short circuit
6.3.11.25. Start the Dashboard and press RESET button
6.3.12. If you experience difficulties in DFU programming, please try the
following:
6.3.12.1.

Use a different computer with a different version of Windows or another
operating system

6.3.12.2.

Install a different DfuSe version (whichever works best with your
Windows)

6.3.13. If you have uploaded the latest firmware for all the boards, you can start
to activate the system:
6.3.14. While the beacon or modem is connected to the Dashboard, click the
DEFAULT button on the Dashboard to upload the default settings. Do it after
each SW upgrade for all devices!
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6.3.15. Write down the beacon’s address for future use or change the address at
your convenience. Enter device address and press ENTER, after - press
write changes button. Beacons addresses should not be repeated.

6.3.16.

Press the RESET button on your beacons and modem after programming

6.3.17. After programming devices with the latest software, the modem and
beacons are ready for use
6.3.18. Place the stationary beacons high on the walls vertically in a way that will
provide optimal ultrasonic coverage. Write down the beacon’s height for future
change in the settings. The help video on installation can be found here - Help:
how to place beacons
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Side view of 2D configuration:
Stationary beacon

Stationary beacon

Mobile beacon

Modem
beacon

≈4-6m

Top view of 2D configuration:

≈6-10m
More information about placement you can find in Placement Manual
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6.3.19. Connect the modem/router via USB to a Windows PC with the Dashboard
installed
6.3.20. Run the Dashboard. In the left corner of the Dashboard, the modem should
be shown as connected
6.3.21.

Wake up all beacons by selecting them on the Dashboard panel

Only 4 stationary beacons may be in 1 submap. If you wake up more beacons,
create new submap for them or it won’t be displayed on the map and in the table
of distances.
6.3.22.

It may take up to 7-10 seconds for the beacons to wake up

6.3.23. Notice, that if the modem is not active and is not powered, the beacons will
go into sleep mode automatically after 1 minute
6.3.24. The system may run the frequency search, if it is the very first time you are
waking up the beacons. If this step does not work, disconnect the modem and
connect that beacon again via USB. Press the DEFAULT button in the
Dashboard and the Read All button to make sure that the radio settings are the
default ones
6.3.25. Check that the radio settings on the modem and the radio settings on the
beacon are the same
6.3.26. Now you can check RSSI, voltage, ultrasonic filter settings, etc. on the
panel on the right corner of the Dashboard
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6.3.27. Enter the height of stationary beacons. Choose beacon in the list and enter
height value

Enter the height for mobile beacon if you are using 2D mode
6.3.28. In the current version one modem supports 250 beacons (mobile +
stationary combined). If you do not see some of your connected beacons on
the map, you may need to scroll to find their addresses
6.3.29. Double click on the device both to put it into sleep mode and to wake
it up

6.3.30.

The map will form and zoom in automatically

6.3.31. If the map does not form well, check the table of distances in the left
corner of the Dashboard. The cells must be colored in white; it means the
distances between stationary beacons are measured correctly
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6.3.32. If you see in the table some empty cells or marked yellow/red, it is an
indication that distances between Some beacons are measured inconsistently
or not measured at all. Try to re-position them because usually there is an
obstruction of some sort in the between the beacons. If you have any problems
– check Table of distances chapter
6.3.33. Make a service zone, clicking on the map with Shift + Left click. See
Submaps chapter for more details

6.3.34. Freeze the Submap by clicking the button. Stationary beacons will stop
measuring relative distances and will be ready to measure distance from the
mobile beacon(s)\
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6.3.35. Turn on and wake up the mobile beacon following the same steps as with
the stationary beacon. More details in our video: https://youtu.be/A4aRsjH2-_E

6.3.36. If you see on the devices’ panel in the Dashboard that the beacon is
colored orange, it means there are some differences in some of the settings
between beacons. For example, some sensors may be off or some ultrasonic
or radio settings may be different. You can change the settings for sensors
manually by clicking on the panel on the upper right corner of the Dashboard
to change the cells from gray to green to turn on sensor. It is recommended
that the default settings on all beacons and the modem are used if this is your
first time using the system.
6.3.37.
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If all looks good and table of distance still colored white, freeze the map.

6.3.38.

The system is now fully operational.

6.3.39. In the Dashboard, you can upload a picture / map of your room. You can
use a different picture for every floor. Go to Loading the floorplan (Help video:
https://www.youtube.com/watch?v=NHUnCtJIYXc)
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6.4.

Starter Set HW v4.9

The steps below describe the very first time you set up of the system in NIA. Beacons
HW v4.9 with the same frequencies and Modem HW v4.9 required.
This is Non-Inverse Architecture. Use NIA Software ONLY

6.4.1.Unpack the system. Watch the help video: https://youtu.be/sOce7B2_6Sk
6.4.2.Charge all the beacons using USB cable. Full charging takes about 1-2 hours

Reset

6.4.3.Turn the beacons on: Place DIP switches as shown on the picture below

Reset button (on side)

DIP switches

6.4.4.Download SW Pack
6.4.5.Update all the beacons (HEX programming):

-

Run the Dashboard and update the SW for all beacons and modem using Dashboard =>
Firmware => Choose the file => Program

-

If you see the message “Not found modem connection to computer through USB” in the
Dashboard or your PC does not recognize beacons/modem, it usually means that the
STM32 driver is not installed. To install the driver, download it with link at top window in the
Dashboard and run the installation file, then click on the link under and install the driver
Ensure that:
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-

You are programming the modem’s SW to the modem and the beacon’s SW to the beacon

-

You are using SW for HW v4.9, if you have HW v4.9; and you have the SW from the same
SW pack, i.e., the Dashboard SW, modem SW, and beacon SW must be from the same
SW pack. Don’t mix SW releases

If SW flashed SUCCESSFULLY, MOVE DIRECTLY TO 4.2.6. If you have some
problems with HEX programming, use DFU programming:
DFU programming or SW uploading is used when HEX SW uploading in the Dashboard
cannot be used. For example, when you are updating from a very old SW version or when
the SW includes major changes to the system and the only possible way to update the SW
is via DFU programming
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6.4.5.1.

After the DFU SW upgrade, future SW upgrades can be done in a regular
manner via the Dashboard

6.4.5.2.

To start programming, move the beacon’s DIP switch to the DFU
programming mode, as described in the paragraph on DIP switch modes

6.4.5.3.

Download the latest SW package, unzip it, and select the proper version
of the SW for your HW and for your frequency variant. Remember that
for DFU programming, you should use DFU SW (DfuSe), not
Dashboard’s .hex file

6.4.5.4.

Download DfuSe

6.4.5.5.

Here you will find different versions of DfuSe. v3.0.5 or v3.0.6, whichever
works the best for your Windows: DfuSe v3.0.5 or DfuSe v3.0.6

6.4.5.6.

DFU Programming:

6.4.5.7.

Put DIP switch into Power = ON, DFU = ON

6.4.5.8.

Connect the beacon via USB to your PC

6.4.5.9.

Run DfuSe

6.4.5.10.

Press the RESET button on your beacon

6.4.5.11.

In the upper left corner of the DfuSe program, you will see a device
connected in the DFU mode
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6.4.5.12.

Choose the DFU driver (file) for the beacon

6.4.5.13.

Click the UPGRADE button

6.4.5.14.

After a couple of seconds, the DFU will be uploaded to the beacon. Make
sure it takes 1–3 seconds and does not happen instantly. Otherwise, the
SW has not been uploaded correctly. If the DFU appears to upload
immediately, check the "Choose" button you used or change the version
of DfuSe SW you selected

6.4.5.15.

Move the DIP switch into Power = ON, DFU = OFF

6.4.5.16.

Start the Dashboard and press the RESET button on the beacon

6.4.5.17.

Check SW on the beacon afterwards

6.4.5.18.

Everything should be OK with SW now. DFU programming is complete

6.4.5.19.

Follow the same scenario for the modem:

6.4.5.20.

Here is the link for the modem DFU programming. The steps are similar
to those for beacon DFU programming

6.4.5.21.

After uploading DFU driver by DfuSe short circuit pins as shown on the
picture (for v4.9) and press Reset button

6.4.5.22.

Modem will go to DFU mode. Press UPGRADE button in the DfuSe
program

6.4.5.23.

After a couple of seconds, the DFU will be uploaded to the modem. Make
sure it takes 1-3 seconds and does not happen immediately. Otherwise,
the SW has not been uploaded correctly. If the DFU appears to upload
immediately, check the "Choose" button you used or change the version
of DfuSe SW to a different one

6.4.5.24.

Disconnect the short circuit

6.4.5.25.

Start the Dashboard and press RESET button

6.4.5.26.

If you experience difficulties in DFU programming, please try the
following:

6.4.5.27.

Use a different computer with a different version of Windows or another
operating system

6.4.5.28.

Install a different DfuSe version (whichever works best with your
Windows)

If you have uploaded the latest firmware for all the boards, you can start to activate the
system:
6.4.6.While the beacon or modem is connected to the Dashboard, click the
DEFAULT button on the Dashboard to upload the default settings

6.4.7.Write down the beacon’s address for future use or change the address at
your convenience as shown here. Beacons addresses should not be
repeated.
6.4.8.Press the RESET button on your beacons and modem after programming
6.4.9.After programming devices with the latest software, the modem and beacons
are ready for use
6.4.10. Place the stationary beacons high on the walls vertically in a way that will
provide optimal ultrasonic coverage. Write down the beacon’s height for future
change in the settings. The help video on installation can be found here https://youtu.be/WY0HkLzmjys
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Side view of 2D configuration:
Stationary beacon

Stationary beacon

Mobile beacon

Modem
beacon

≈4-6m

Top view of 2D configuration:

≈6-10m
6.4.11. Connect the modem/router via USB to a Windows PC with the Dashboard
installed
6.4.12. Run the Dashboard. In the left corner of the Dashboard, the modem should
be shown as connected
6.4.13.

Wake up all beacons by selecting them on the Dashboard panel

Only 4 stationary beacons may be in 1 submap. If you wake up more beacons,
create a new submap for them or it won’t be displayed on the map and in the
table of distances
6.4.14.

It may take up to 7-10 seconds for the beacons to wake up

6.4.15. Notice, that if the modem is not active and is not powered, the beacons will
go into sleep mode automatically after 1 minute
6.4.16. The system may run the frequency search, if it is the very first time you are
waking up the beacons. If this step does not work, disconnect the modem and
connect that beacon again via USB. Press the DEFAULT button in the
Dashboard and the Read All button to make sure that the radio settings are the
default ones
6.4.17. Check that the radio settings on the modem and the radio settings on the
beacon are the same
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6.4.18. Now you can check RSSI, voltage, ultrasonic filter settings, etc. on the
panel on the right corner of the Dashboard

6.4.19. Enter the height of stationary beacons. Choose beacon in the list and
enter height value

Enter the height for mobile beacon if you use 2D mode
6.4.20. In the current version one modem supports 250 beacons (mobile +
stationary combined). If you do not see some of your connected beacons on
the map, you may need to scroll to find their addresses
6.4.21.

Double click on the device both to put it into sleep mode and to wake it up

6.4.22.

The map will form and zoom in automatically

6.4.23. If the map does not form well, check the table of distances in the left
corner of the Dashboard. The cells must be colored in white; it means the
distances between stationary beacons are measured correctly

97

6.4.24. If you see in the table some empty cells or marked yellow/red, it is an
indication that distances between Some beacons are measured
inconsistently or not measured at all. Try to re-position them because usually
there is an obstruction of some sort in the between the beacons. If you have
any problems – check Table of distances chapter
6.4.25. Make a service zone, clicking on the map with Shift + Left Click. See
Submaps chapter for more details
6.4.26. Freeze the map by clicking the button. Stationary beacons will stop
measuring relative distances and will be ready to measure distance from the
mobile beacon(s)

6.4.27. Turn on and wake up the mobile beacon following the same steps as with
the stationary beacon. More details in our video: Demo: converting beacon to
mobile beacon ("hedgehog")
6.4.28. If you see on the devices’ panel in the Dashboard that the beacon is
colored orange, it means there are some differences in some of the settings
between beacons. For example, some sensors may be off or some ultrasonic
or radio settings may be different. You can change the settings for sensors
manually by clicking on the panel on the upper right corner of the Dashboard
to change the cells from gray to green to turn on sensor. It is recommended
that the default settings on all beacons and the modem are used if this is your
first time using the system.
6.4.29. After you freeze the map of stationary beacons, wake up the mobile
beacon. After it wakes up, it will be traceable within 5-7 seconds.
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6.4.30.

The system is now fully operational.

6.4.31. In the Dashboard, you can upload a picture/map of your room. You can
use a different picture for every floor. Go to Loading the floorplan
(Help video: https://www.youtube.com/watch?v=NHUnCtJIYXc)
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6.5.

Starter Set NIA-SmallDrone

The steps below describe the very first time you set up the system. Super-Beacon, MiniTX beacons and modem required. Note: steps below feature the Mini-RX, which is not
part of the set anymore. This will be updated later, but the process is still the same.
Super-Beacon and Mini-TX have different HW and SW from HW v4.9. Use SuperBeacon SW for Super-Beacons, Mini-TX SW for Mini-TX beacons, HW v4.9’s SW for
HW v4.9

6.5.1.Unpack the system. Take a look at a similar unpacking video of HW v4.9.
The videos have certain differences but the basic are the same:
https://youtu.be/sOce7B2_6Sk
6.5.2.Charge all the beacons using USB cable. Full charging takes about 1-2 hours
6.5.3.Turn the beacons on
6.5.4.Download SW Pack

Reset

6.5.5.Update all the beacons:

Reset button (on side)

DIP switches

Reset button
DIP switches
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-

Run the Dashboard and update the SW for all beacons and modem using Dashboard =>
Firmware => Choose the file => Program

-

If you see the message “Not found modem connection to computer through USB” in the
Dashboard or your PC does not recognize beacons/modem, it usually means that the
STM32 driver is not installed. To install the driver, download it through the link in the top
window in the Dashboard and run the installation file, then click on the link under and install
the driver
Make sure that that:

-

You are programming the modem’s SW to the modem and the beacon’s SW to the
beacon

-

You are using SW for Mini-TX, if you have Mini-TX; and you have the SW from the same
SW pack, i.e., the Dashboard SW, modem SW, and beacon SW must be from the same
SW pack. Don’t mix SW releases
If SW flashed SUCCESSFULLY, MOVE DIRECTLY TO 4.4.6. If you have some
problems with HEX programming, use DFU programming:
DFU programming or SW uploading is used when HEX SW uploading in the Dashboard
cannot be used. For example, when you are updating from a very old SW version or when
the SW includes major changes to the system and the only possible way to update the SW
is via DFU programming
6.5.5.1.

After the DFU SW upgrade, future SW upgrades can be done in a
regular manner via the Dashboard

6.5.5.2.

To start programming, move the beacon’s DIP switch to the DFU
programming mode, as described in the paragraph on DIP switch modes
(DIP switch in Mini-RX and Mini-TX situated inside the body. Carefully
disassemble the body to access it, as described in paragraph How to
Flash Beacon Mini-RX)

6.5.5.3.

Download the latest SW package, unzip and select the proper version of
the SW for your HW and for your frequency variant. Remember that for
DFU programming, you should use DFU SW (DfuSe), not Dashboard’s
.hex file

6.5.5.4.

Download DfuSe

6.5.5.5.

Here you will find different versions of DfuSe. v3.0.5 or v3.0.6, whichever
works the best for your Windows: DfuSe v3.0.5 or DfuSe v3.0.6

DFU Programming:
6.5.5.6.
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Put DIP switch into Power = ON, DFU = ON (DIP switch in Mini-RX
and Mini-TX situated inside the body. To switch it, carefully
disassemble the body)

6.5.5.7.

Connect the beacon via USB to your PC

6.5.5.8.

Run DfuSe

6.5.5.9.

Press the RESET button on your beacon

6.5.5.10.

In the upper left corner of the DfuSe program, you will see a device
connected in the DFU mode

6.5.5.11.

Choose the DFU driver (file) for the beacon

6.5.5.12.

Click the UPGRADE button

6.5.5.13.

After a couple of seconds, the DFU will be uploaded to the beacon. Make
sure it takes 1–3 seconds and does not happen instantly. Otherwise, the
SW has not been uploaded correctly. If the DFU appears to upload
immediately, check the "Choose" button you used or change the version
of DfuSe SW you selected

6.5.5.14.

Move the DIP switch into Power = ON, DFU = OFF

6.5.5.15.

Start the Dashboard and press the RESET button on the beacon

6.5.5.16.

Check SW on the beacon afterwards

6.5.5.17.

Everything should be OK with SW now. DFU programming is complete

Follow the same scenario for the modem:
-
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Here is the link for the modem DFU programming. The
steps are similar to those for beacon DFU programming

6.5.5.18.

After uploading DFU driver by DfuSe short circuit pins as shown on the
picture and press Reset button

6.5.5.19.

Modem will go to DFU mode. Press UPGRADE button in the DfuSe
program

6.5.5.20.

After a couple of seconds, the DFU will be uploaded to the modem. Make
sure it takes 1-3 seconds and does not happen instantly. Otherwise, the
SW has not been uploaded correctly. If the DFU appears to upload
immediately, check the "Choose" button you used or change the version
of DfuSe SW to a different one

6.5.5.21.

Disconnect the short circuit

6.5.5.22.

Start the Dashboard and press RESET button

If you have uploaded the latest firmware for all of the boards, you can start to activate the
system:
6.5.6.While the beacon or modem is connected to the Dashboard, click the
DEFAULT button on the Dashboard to upload the default settings
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6.5.7.Write down the beacon’s address for future use or change the address at
your convenience as shown here

6.5.8.Press the RESET button on your beacons and modem after programming
6.5.9.After programming devices with the latest software, the modem and beacons
are ready for use
6.5.10. Place the stationary beacons high on the walls vertically in a way that will
provide optimal ultrasonic coverage. Write down the beacon’s height for future
change in the settings. The help video on installation can be found here https://youtu.be/WY0HkLzmjys
Side view:
Stationary beacon

Stationary beacon

Stationary beacon

Mobile beacon

Modem
beacon
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≈4-6m

Top view:

≈6-10m
6.5.11. Connect the modem/router via USB to a Windows PC with the
Dashboard installed
6.5.12. Run the Dashboard. In the left corner of the Dashboard, the modem
should be shown as connected
6.5.13.

Wake up all beacons by selecting them in the Dashboard on the panel

6.5.14.

It may take up to 7-10 seconds for the beacons to wake up

6.5.15. Notice, that if the modem is not active and is not powered, the beacons
will go into sleep mode automatically after 1 minute
6.5.16. The system may run the frequency search, if it is the very first time you are
waking up the beacons. If this step does not work, disconnect the modem and
connect that beacon again via USB. Press the DEFAULT button in the
Dashboard and the Read All button to make sure that the radio settings are the
default ones
6.5.17. Check that the radio settings on the modem and the radio settings on the
beacon are the same
6.5.18. Now you can check RSSI, voltage, ultrasonic filter settings, etc. on the
panel on the right corner of the Dashboard

6.5.19. Enter the height of stationary beacons. Choose beacon in the list and
enter height value
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Enter the height for mobile beacon if you used 2D mode
6.5.20. In the current version one modem supports 250 beacons (mobile +
stationary combined). If you do not see some of your connected beacons on
the map, you may need to scroll to find their addresses
6.5.21.

Double click on the device to put it into sleep mode or wake it up

Only 4 stationary beacons may be in 1 submap. If you wake up more beacons,
create a new submap for them, otherwise it will not be displayed on the map and
in the table of distances.
6.5.22.

Build the map:

Mini-RX beacons cannot build the map automatically, manual inputting of the
coordinates is required
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6.5.22.1.

Open the Dashboard. You will see the table of distances

6.5.22.2.

Right click on the cell where you want to enter the distance. Additional
menu will open. There you can control the table of distances. Choose
Enter distance for pair to enter the value

6.5.22.3.

Now, enter measured (measure it with laser distance meter or so) value.
That values would not change until you unfreeze or clear it. Even if
beacons had been moved, distance would stay. Be careful with frozen
cells because a small mistake can cause a significant impact on your
tracking

6.5.22.4.

Repeat for all cells

6.5.23. Freeze the map by clicking the button. Stationary beacons will stop
measuring relative distances and will be ready to measure distance from the
mobile beacon(s)

6.5.24. Turn on and wake up the mobile beacon following the same steps as with
the stationary beacon: https://youtu.be/A4aRsjH2-_E
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6.5.25. If you see on the devices’ panel in the Dashboard that the beacon is
colored orange, it means there are some differences in some of the settings
between beacons. For example, some sensors may be off or some ultrasonic
or radio settings may be different. You can change the settings for sensors
manually by clicking on the panel on the upper right corner of the Dashboard
to change the cells from gray to green to turn on sensor. It is recommended
that the default settings on all beacons and the modem be used if this is your
first time using the system.
6.5.26.

After you freeze the map of stationary beacons, wake up the mobile

beacon. After it wakes up, it will be traceable in 5-7 seconds.
6.5.27.
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The system is now fully operational.

6.6.

Starter Set Industrial-NIA-01

The steps below describe the first set up of the system.
This is a Non-Inverse Architecture. You can find the description and comparison of
architectures here.
Pay attention: Industrial beacons have different HW and SW from HW v4.9. It has
different connectors, reset and DFU activation. Read more on Industrial beacon page.
Industrial beacons have no battery, use power supply cable.
Use Industrial beacon’s SW for Industrial beacons, v4.9 for v4.9.
Do not disassemble the Industrial beacons. Otherwise, warranty will be lost
Version 3 of Industrial RX (from April 2022) supports ONLY +5V power supply. Don’t
use +12V power supply converter for this version, it will burn the beacon!
Version 3 doesn’t have UART RX, but now is possible to use Interface connector as a
power supply. For this version.

6.6.1.Unpack the system. Take a look at the similar unpacking video of HW v4.9.
They
are
different,
but
have
some
similar
basics:
https://youtu.be/sOce7B2_6Sk
6.6.2.You do not have to charge Industrial beacons; they have no battery
6.6.3.You do not have to turn it on - Industrial beacons are permanently ON
6.6.4.Download SW Pack
6.6.5.Update all the beacons:

Magnetic Reset side
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Magnetic DFU switch side

Magnetic Reset side

Magnetic DFU switch side

-

Run the Dashboard and update the SW for all beacons and modem using Dashboard =>
Firmware => Choose the file => Program

-

If you see the message “Not found modem connection to computer through USB” in the
Dashboard or your PC does not recognize beacons/modem, it usually means that the
STM32 driver is not installed. To install the driver, download it with link at top window in the
Dashboard and run the installation file, then click on the link under and install the driver
Ensure that:

-

You are programming the modem’s SW to the modem and the beacon’s SW to the beacon

-

You are using SW for 4.9, if you have HW v4.9; and you have the SW from the same SW
pack, i.e., the Dashboard SW, modem SW, and beacon SW must be from the same SW
pack. Don’t mix SW releases
If SW flashed SUCCESSFULLY, MOVE DIRECTLY TO 4.6.6. If you have some
problems with HEX programming, use DFU programming:
DFU programming or SW uploading is used when HEX SW uploading in the Dashboard
cannot be used. For example, when you are updating from a very old SW version or when
the SW includes major changes to the system and the only possible way to update the SW
is via DFU programming
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-

After the DFU SW upgrade, futures SW upgrades can be done in a regular manner
via the Dashboard

-

Industrial beacons have magnetic DFU mode and reset

-

Download the latest SW package, unzip it, and select the proper version of the SW for
your HW and for your frequency variant. Remember that for DFU programming, you
should use DFU SW (DfuSe), not Dashboard’s .hex file

-

Download DfuSe

-

Here you will find different versions of DfuSe. v3.0.5 or v3.0.6, whichever works the
best for your Windows: DfuSe v3.0.5 or DfuSe v3.0.6

DFU Programming:
Uploading Beacon Industrial’s (Not super) DFU software to Industrial SuperBeacon hardware make permanently damage for Industrial Super-Beacon board.
Be double attentive with update
6.6.5.1.

Activate DFU mode and reset the beacon (Industrial beacons have
magnetic DFU mode and reset). Place first magnet (any strong and
modern magnet) to the right side of the beacon (Step 1). After that, place
second magnet to the left side of the beacon and remove it in a second,
just to reset it (Step 2)

Step 1: DFU mode

Step 2: Reset

Magnet examples
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6.6.5.2.

Connect the beacon via USB to your PC

6.6.5.3.

Connect power supply cable to your beacon

6.6.5.4.

Run DfuSe

6.6.5.5.

In the upper left corner of the DfuSe program, you will see a device
connected in the DFU mode

6.6.5.6.

Choose the DFU driver (file) for the beacon

6.6.5.7.

Click the UPGRADE button

6.6.5.8.

After a couple of seconds, the DFU will be uploaded to the beacon. Make
sure it takes 1–3 seconds and does not happen instantly. Otherwise, the
SW has not been uploaded correctly. If the DFU appears to upload
immediately, check the "Choose" button you used or change the version
of DfuSe SW you selected

6.6.5.9.

Start the Dashboard

6.6.5.10.

Reset the beacon again

6.6.5.11.

Check SW on the beacon afterwards

6.6.5.12.

Everything should be OK with SW now. DFU programming is complete.

DFU Programming for the modem:
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6.6.5.13.

Here is the link for the modem DFU programming. The steps are similar
to those for beacon DFU programming.

6.6.5.14.

After uploading DFU driver by DfuSe short circuit pins as shown on the
picture (for v4.9) and press Reset button

6.6.5.15.

Modem will go to DFU mode. Press UPGRADE button in the DfuSe
program

6.6.5.16.

After a couple of seconds, the DFU will be uploaded to the modem. Make
sure it takes 1-3 seconds and does not happen instantly. Otherwise, the
SW has not been uploaded correctly. If the DFU appears to upload
immediately, check the "Choose" button you used or change the version
of DfuSe SW to a different one.

6.6.5.17.

Disconnect the short circuit.

6.6.5.18.

Start the Dashboard and press RESET button.

6.6.6.If you have uploaded the latest firmware for all the boards, you can start to
activate the system:
6.6.7.While the beacon or modem is connected to the Dashboard, click the
DEFAULT button on the Dashboard to upload the default settings
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6.6.8.Write down the beacon’s address for future use or change the address at
your convenience as shown here

6.6.9.Press the RESET (Industrial beacons have magnetic re button on your
beacons and modem after programming
6.6.10. After programming devices with the latest software, the modem and
beacons are ready for use
6.6.11. Place the stationary beacons high on the walls vertically in a way that will
provide optimal ultrasonic coverage. Write down the beacon’s height for
future change in the settings. The help video on installation can be found
here - https://youtu.be/WY0HkLzmjys
Side view:
Stationary beacon

Stationary beacon

Stationary beacon

Mobile beacon

Modem
beacon
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≈4-6m

Top view:

≈6-10m

6.6.12. Connect the modem/router via USB to a Windows PC with the
Dashboard installed
6.6.13. Run the Dashboard. In the left corner of the Dashboard, the modem
should be shown as connected
6.6.14. Wake up all beacons by clicking on the buttons in the Dashboard on the
panel

6.6.15.

It may take up to 7-10 seconds for the beacons to wake up

6.6.16. If the modem is not active and is not powered, the beacons will go into
sleep mode automatically after 1 minute
6.6.17. The system may run the frequency search, if it is the very first time you are
waking up the beacons. If this step does not work, disconnect the modem and
connect that beacon again via USB. Press the DEFAULT button in the
Dashboard and the Read All button to make sure that the radio settings are the
default ones
6.6.18. Check that the radio settings on the modem and the radio settings on the
beacon are the same
6.6.19. Now you can check RSSI, voltage, ultrasonic filter settings, etc. on the
panel on the right corner of the Dashboard
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6.6.20. Enter the height of stationary beacons. Choose beacon in the list and
enter height value

Enter the height for mobile beacon if you use 2D mode
6.6.21. In the current version one modem supports 250 beacons (mobile +
stationary combined). If you do not see some of your connected beacons on
the map, you may need to scroll to find their addresses
6.6.22.

Double click on the device to put it into sleep mode or wake it up

Only 4 stationary beacons may be in 1 submap. If you wake up more beacons,
create new submap for them. Or it won’t be displayed on the map and in the table
of distances
6.6.23.

Build the map:

Industrial-RX beacons are not possible to build the map automatically, so you
have to build it manually
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6.6.23.1.

Open the Dashboard. You will see the table of distances

6.6.23.2.

Right click on the cell where you want to enter the distance. Additional
menu will open. There you can control the table of distances. Choose
Enter distance for pair to enter the value

6.6.23.3.

Now, enter measured (measure it with laser distance meter or so) value.
That values would not change until you unfreeze or clear it. Even if
beacons had been moved, distance would stay. Be careful with frozen
cells because a small mistake can cause a huge impact on your tracking

6.6.23.4.

Repeat for all cells

6.6.24. Freeze the map by clicking the button. Stationary beacons will stop
measuring relative distances and will be ready to measure distance from the
mobile beacon(s)

6.6.25. Turn on and wake up the mobile beacon following the same steps as with
the stationary beacon: https://youtu.be/A4aRsjH2-_E
6.6.26. If you see on the devices’ panel in the Dashboard that the beacon is
colored orange, it means there are some differences in some of the settings
between beacons. For example, some sensors may be off or some ultrasonic
or radio settings may be different. You can change the settings for sensors
manually by clicking on the panel on the upper right corner of the Dashboard
to change the cells from gray to green to turn on sensor. It is recommended
that the default settings on all beacons and the modem be used if this is your
first time using the system
6.6.27. After you freeze the map of stationary beacons, wake up the mobile
beacon. After it wakes up, it will be traceable within 5-7 seconds
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6.6.28.
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The system is now fully operational

7. Dashboard menu and Parameters
7.1.

Dashboard general view

This picture shows the Dashboard’s general interface and items’ positions

Table of
distances

Diagnostics messages
window

Visualization
window

Modem/beacon’s
settings bar
Ceiling and
mirroring buttons

Visualization
settings

Modem

GPS/Robots/Workers

Devices list
Map settings
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Modem/beacon’s
quick control panel

7.2.

Diagnostics messages window

Diagnostic messages window is an area where important system’s messages appears.
It may contain a lot of useful information.
Diagnostics window is placed on the top of the Dashboard.

If the field is empty, that means that system didn’t find any issues for the launch. If you
have any messages, please check it carefully and fix the issue.
There are 4 categories of reports:
-
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Orange – minor issue
Red – major issue
Green – Successfully completed settings
Blue – Successfully completed process

Here is the list of the messages (relevant for Dashboard v7.200):
Left diagnostic window:
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-

Same ultrasonic frequency in submap0 beacons: n2, n3 - use beacons with
different frequencies in IA submaps

-

Paired beacons 25/26 ultrasonic and IMU fusion not completed. Angular
difference: 45 degrees appears if angle difference between beacons more than 5
degrees

-

IA architecture can't be selected. Upload IA firmware to modem

-

NIA architecture can't be selected. Upload NIA firmware to modem

-

MF NIA architecture can't be selected. Upload NIA firmware to modem

-

No MF NIA license (MMSW0004) for beacons n5, n6, n7. Buy the license. MF
NIA doesn’t work even if license not activated for one beacon in the system.

-

Device N10 (V7.000) not supported

-

N10 (V7.000) - too old. Update firmware

-

N10 (V7.000) - newer than dashboard. Update dashboard

-

N10 (V7.000) - older than modem. Update firmware

-

N10 (V7.000) - newer than modem. Update modem firmware

-

Mixed IA and NIA devices

-

UBX protocol for PX4 requires license MMSW0003. Buy the license.

-

Beacons not assigned to submaps: n10, n11. All submaps frozen. Unfreeze or
add submap

-

Beacons not assigned to submaps: n10, n11. Maximum 4 beacons per submap.
Add submap

-

Beacons too close: n10, n11. Place beacons at least 2 meters from modem

-

Devices with duplicated address: n10, n11

-

FEC mismatch to modem: n10, n11 - change FEC in radio parameters

-

Discharged devices: n10, n11

-

'Distances were changed in frozen submap0

-

Sleeping beacons in frozen submap0

-

Network setting read failed - Error reading Super-Modem network settings

-

Network setting write failed - Error writing super modem network settings

-

Not found UWB device - connect UWB beacon or UWB modem to modem HW
v5.1 (only for Marvelmind UWB devices. In progress)

-

Single hedge readout per cycle - increase the value and refreeze the map - In IA,
in the modem settings, the number of transmitted coordinates of hedgehogs per
cycle 1 is entered. This greatly slows down the update of coordinates of
hedgehogs in the dashboard (if there are many of them). By default, this
parameter is 10

-

Modem HW v4.9 doesn''t support MF NIA

-

You need at least 3 beacons for MF NIA. Add beacons.

-

Uploading map to beacons n10, n11, n12

-

Check table of distances for submap 0 – Table of distance is not white (there are
discrepancies in distances)

-

More than one beacon nailed to floorplan: n10, n11. Unnail for scaling

-

Floorplan scaling: click first point on floorplan. ESC to cancel.

-

Floorplan scaling: click second point on floorplan. ESC to cancel.

-

Floorplan is glued. Can't scale

-

Floorplan is glued. Can't move

-

Can't move submap - beacons n10, n11 are nailed to floorplan

-

Can't move submap - beacons n10, n11 are fixed

-

Can't rotate submap - beacons n10, n11 are nailed to floorplan

-

Can't rotate submap - beacons n10, n11 are fixed

-

Can't move: beacon n10 is nailed to floorplan

-

More than one fixed beacon in submap0. Submap doesn't automatically rebuild

-

Not found USB connection. Possibly driver not installed. Download and install
driver

-

Can't set manual location. Beacon 10 is in frozen submap0. Unfreeze for manual
location

-

Enable Interfaces/IMU via modem/Raw IMU data to see gyro

-

Enable Interfaces/IMU via modem/Raw IMU data to see accelerometer

-

Beacon n10 has no license MMSW0007. Buy the license

-

Beacon n10 has no license MMSW0008. Buy the license

-

Map upload finished

-

Switch to recorded state 719 - Revert to previous state by CTRL+Z (license 7.1
required)

-

Licenses updated

-

Paired beacons 25/26 ultrasonic and IMU fusion completed. Angular difference:
2 degrees. 4

-

Network setting read completed

-

Network setting write completed

Right diagnostic window:

122

-

Adding beacons on frozen map disabled

-

Stream capture mode was disabled

-

Map is not frozen

-

Submaps not frozen: 0, 1, 2

-

No optional SW pack license (MMSW0005) for beacons: n10, n11

-

Stream capture mode enabled

7.3.

Table of distances

Table of distances shows the measured distance between all beacons. The map and
its graphical visualization depend on distances, which is a very important part of the
system.
There are two ways of measuring:

-

Measuring by ultrasound (automatic)
Measuring by user (manual)

Measuring by ultrasound is impossible for Mini-RX and Industrial-RX beacons
In noisy cases and cases with long distances it is better to use manual input
7.3.1.Measuring by ultrasound:

-

In most cases, the system builds the table of distances automatically. If everything is
good, there would be figures in cells, they would be changing a little; the color of each cell
would be white

-

If color differs, check the colors’ definitions (next page) and solve the problem

-

Freeze the map only if cells are white
7.3.2.Measuring by user (necessary for Mini-RX beacons and noisy cases):

-

Use manual input if table of distances didn’t build. It may happen if environment is
very noisy, or distances are very huge

-

In that case, cells’ color would be green

-

Be careful with figures because a small mistake in the values will cause mistakes in
location

How to freeze/enter distance manually:
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7.3.2.1.

Open the Dashboard. You will see the table of distances

7.3.2.2.

Right click on the cell you want to freeze/enter. Additional menu will
open. There you can control the table of distances. Choose Freeze
distance for pair to freeze it

7.3.2.3.

Now, cells are frozen. That values would not change until you unfreeze
it. Even if beacons had been moved, distance would stay. Be careful
with frozen cells because a small mistake can cause a huge impact on
your tracking

7.3.2.4.

Repeat for all cells

- White means that everything is good, you can freeze the map
- Yellow means that something seems to be wrong, check distances and sensors before freezing

- Red means some critical misses, DO NOT freeze the map. Manually measure and enter distances
- Green means frozen distance, you can freeze the map, but be careful with values
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7.4.

Devices List

Devices list contains information about all the beacons in the system. It also allows to
search, add and delete it.

Devices in this section are divided into two types:

-

Stationary beacon (beacon)
Mobile beacon (hedge)

Devices list allows user to manage devices
Use double click to put beacon into sleep mode
7.4.1.Stationary beacon (beacon)

-

Right click to open additional menu
There you can:

-

Remove beacon from current submap
Remove beacon from the whole network
Manually setup coordinates (x, y, z)

7.4.2.Mobile beacon (hedge)

-

Right click to open additional menu
There you can:

-
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Remove beacon from the network
Setup movement path
Upload zones (allowed and denied)
Manually setup coordinates (x, y, z)

7.5.

Visualization settings

Visualization settings window has some functions to control visualization process:

-
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Clear map – clear all movement path
Dots timeout – time of path’s existence (Video: Help: Dots timeout)
Dots size mode – size of dots
Save screenshot – files save to Dashboard’s folder/screenshots
Freeze screen – The map freeze, no updates of the path

7.6.

Map Settings

Map Settings offer some helpful tools:
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-

Save map – saves map as .ini file into Dashboard folder/maps
Load map – loads map from .ini format file
Erase map – erases map and clears it

-

New/merge – build new map or upgrade current map

7.7.

Modem/beacon’s quick control panel

Control panel allows user to interact with devices. It can work with one device, or with
all devices in the system.
List of functions:

-

Reset – Resets device
Sleep – Send device asleep (battery economy mode)
Wake up – Wakes up device (from sleeping mode)
Default – Drops all device’s settings to factory default
Time sync – Sends time from your PC to hedgehog (for stream it out via UART)

Additional Ctrl feature:

-
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To apply action to all beacons in the system, use Ctrl + Left Click on button. Applicable
only for buttons that turn bold while Ctrl is pressed.

7.8.
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Celling and Mirroring buttons on the Dashboard

-

The Mirroring button allows the map to be display as a mirror reflection

-

The Ceiling button shows where the mobile beacon is located with respect to the stationary
beacons

-

When the arrow points up, it means that the mobile beacon is below the stationary beacons

-

When the arrow points down, it means that the mobile beacon is above the stationary
beacons

-

The Center Map button

7.9.

Detailed settings

This bar allows user to adjust devices very precisely. It contains a lot of parameters for
advanced usage

7.9.1. Modem Settings
7.9.1.1. Basic Settings

Unique processor ID for each device (beacon or modem)

Firmware version of device (beacon or modem)

Architecture type (IA or NIA)

Location update rate settings: 1/20Hz – 16Hz+.
Notice that real update rate may be limited by distances
between beacons or radio profile

Power supply voltage of the device 5V+-0.2V is OK

Time from the latest reset

Strength of the radio signal to modem from beacons and
vice versa. Maintain in the range of -25dBm to -80..90dBm. Higher value - may overload. Lower – lost packets

Strength of the radio signal from modem to beacons and
vice versa. Maintain in the range of -25dBm to -80..90dBm. Higher value - may overload. Lower – lost packets

Chosen working band

Exact working frequency
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Pre-selected channel – one of the radio channels for
communication between modem and beacons

Logical address of the device. Keep 2..255 for beacons.
Address

TBD

Averaging between location update measurements. More
value – less location jitter, but higher latency
Filter of distances (as opposed to filter of locations). More –
better filtering, but may be too conservative and “kill” good
measurements
TBD

Keep Enabled normally. Switch to cm for backward
compatibility

If map is frozen, new beacons will be accepted in the map,
if enabled
Measured temperature of the processor’s crystal

TBD
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7.9.1.2. Advanced settings

TBD

TBD

TBD

TBD

TBD

TBD

TBD

If modem lost connection it restarts by itself

TBD

TBD

TBD
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7.9.1.3. Parameters of radio
Real carrier frequency

Selected radio profile with a set of profile settings.
Choose between 38kbps (better range and interference
immunity, but slower); 153kbps – balanced; and 500kbps –
the fastest, but the lowest radio range and least immune to
interference
Logical address of the device. Distinguish of beacon from
another

One of a predefined radio frequency channels

Modulation – a part of the radio profile. Only for advanced
users

Only for advanced users

Only for advanced users

Only for advanced users
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Radio profile settings. No need to change manually. Only
for advanced users

Radio profile settings. No need to change manually. Only
for advanced users

Radio profile settings. No need to change manually. Only
for advanced users

Radio profile settings. No need to change manually. Only
for advanced users

Radio profile settings. No need to change manually. Only
for advanced users

Radio profile settings. No need to change manually. Only
for advanced users

Radio profile settings. No need to change manually. Only
for advanced users

Radio profile settings. No need to change manually. Only
for advanced users
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7.9.1.4. Interfaces

Speed of UART

Type of protocol

Enable or disable receiving raw IMU data with IMU update
rate (100Hz)

TBD

TBD

TBD

TBD

TBD

TBD

TBD

TBD

135

7.9.2. Beacon’s settings
7.9.2.1. Basic settings

Unique CPU ID

Firmware version of device (beacon or modem)

TBD

Enable for mobile beacon and disable for stationary beacon

Measured voltage of internal battery

Time from the latest reset

Strength of the radio signal from modem to this beacon, i.e.
how the beacon “hears” the modem over radio. Keep below 25dBm and above -80dBm to avoid losses of packets. Lower
end depends on radio profile and interference
Strength of the radio signal from this beacon to the modem, i.e.
how the modem “hears” the beacon over radio. Keep below 25dBm and above -80dBm to avoid losses of packets. Lower
end depends on radio profile and interference
TBD

Select radio frequency band according to your HW:
433MHz or 915MHz

Real carrier frequency
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Selected radio channel

Selected device’s address

Height – must be set for stationary beacons.
Must also be set for mobile beacons in 1D or 2D modes

Processor’s crystal’s temperature

Frequency of ultrasonic pulses – set according to your HW

TBD

TBD

TBD

TBD
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7.9.2.2. IMU
Calibration settings of embedded IMU: X shift

Calibration settings of embedded IMU: Y shift

Calibration settings of embedded IMU: Z shift

Calibration settings of embedded IMU: X scale

Calibration settings of embedded IMU: Y scale

Calibration settings of embedded IMU: Z scale
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7.9.2.3. Parameters of radio
Real carrier frequency

Radio profile that is linked with many radio settings below.
Helps to set them at once by choosing the profile. See
similar in modem for more info
Device address – shall be set for each beacon different
under one modem

One of the pre-selected frequency channels

Radio profile settings. No need to change manually. Only
for advanced users

Radio profile settings. No need to change manually. Only
for advanced users

Radio profile settings. No need to change manually. Only
for advanced users

Radio profile settings. No need to change manually. Only
for advanced users
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Radio profile settings. No need to change manually. Only
for advanced users

Radio profile settings. No need to change manually. Only
for advanced users

Radio profile settings. No need to change manually. Only
for advanced users

Radio profile settings. No need to change manually. Only
for advanced users

Radio profile settings. No need to change manually. Only
for advanced users

Radio profile settings. No need to change manually. Only
for advanced users

Radio profile settings. No need to change manually. Only
for advanced users

Radio profile settings. No need to change manually. Only
for advanced users
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7.9.2.4. Ultrasound
TX-RX – regular mode. Use it. The rest - internal

TBD

Power saving features. If not sure, keep default

Power saving features. If not sure, keep default

TBD

Frequency of ultrasonic pulses – set according to your HW

50% - default. 1% … 99% lower strength of ultrasonic.
Keep default

Number of ultrasonic pulses the TX beacon emits. More –
stronger, but longer echo. For small distances – 1-10
periods. 20-30 – for 10-20 meters. For 20+ m – 50 periods
Internal settings

Automatic or manual gain control.
Manual can be useful in special conditions: too high
external audio noise, for example
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TBD

AGC settings. For advanced users only

AGC settings. For advanced users only

AGC settings. For advanced users only

AGC settings. For advanced users only

Deep ultrasonic trigger settings. For special cases only

Deep ultrasonic trigger settings. For special cases only

Keep ADC

Deep ultrasonic trigger settings. For special cases only

Deep ultrasonic trigger settings. For special cases only
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Deep ultrasonic trigger settings. For special cases only

Deep ultrasonic trigger settings. For special cases only

Deep ultrasonic trigger settings. For special cases only

Deep ultrasonic trigger settings. For special cases only

Deep ultrasonic trigger settings. For special cases only
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Deep AGC settings. For special cases only

Deep AGC settings. For special cases only

Deep AGC settings. For special cases only

Deep AGC settings. For special cases only

TBD

TBD

TBD

TBD

TBD

Enable/disable sensor RX1 in map building mode

Enable/disable sensor RX2 in map building mode
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Enable/disable sensor RX3 in map building mode

Enable/disable sensor RX4 in map building mode

Enable/disable sensor RX5 in map building mode

Enable/disable sensor RX1 in map frozen/regular work
mode

Enable/disable sensor RX2 in map frozen/regular work
mode

Enable/disable sensor RX3 in map frozen/regular work
mode

Enable/disable sensor RX4 in map frozen/regular work
mode

Enable/disable sensor RX5 in map frozen/regular work
mode

TBD

TBD

TBD
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7.9.2.5. Interfaces
Speed of UART in hedgehog mode

Type of protocol

TBD

Enable or disable receiving raw IMU data with IMU update
rate (100Hz)

Enable or disable receiving IMU+ultrasonic sensor fusion
data with IMU update rate (100Hz)

7.9.2.6. Georeferencing
The same as with modem

The same as with modem

7.9.2.7. Misc. settings
Timeout sleep settings
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7.9.2.8. Hedgehogs pairing
Enable for Paired Beacons feature:
https://youtu.be/aBWUALT3WTQ
Also look at chapter 6.13

Activate this parameter to pair beacons

Address of the beacon, current selected hedgehog paired
with

Location against center of selected beacon in a pair

Actual distance between paired hedgehogs

TBD

TBD

TBD
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7.10. Radio frequency band and Carrier frequency
-

For devices with HW 433 MHz allowable Radio bands 315 and 433,

-

For devices with HW 915 MHz allowable Radio bands 868 and 915, but when using antennas
at 433 MHz it is possible to use both 315 and 433 MHz

*Mini-RX beacons and Super-Beacons are 868/915MHz only
It is possible to change the frequency of radio, but radio performance can be severely
degraded. It may be enough for smaller distances, up to 10-20 meters, but not more.
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7.11. Different hedgehog colors in the Dashboard
You can choose any color for your hedge, but it still has some permanent colors, which
inform you about some tracking issues:

-

Blue - normal mode and confident tracking

-

Orange - system provides the best location data possible, but confidence is lower than
blue
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-

Transparent Blue - lost radio packets

-

Transparent Orange – weak ultrasonic coverage

7.12. Different beacons’ colors in the Dashboard
Beacons can have different ultrasonic frequency. Because of that, they have different
colors to make them easier to distinguish:

-

Stationary beacons – Green center –

-

Mobile beacons – Dark blue center –

Examples:
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-

Stationary beacons:

-

19KHz beacon

-

22kHz

-

25KHz beacon

-

28kHz

-

31KHz beacon

-

34kHz

-

37KHz beacon

-

45KHz beacon

-

Mobile beacons:

-

19KHz beacon

-

22kHz

-

25KHz beacon

-

28kHz

-

31KHz beacon

-

34 kHz

-

37KHz beacon

-

45KHz beacon

8. The Map
8.1.

Introduction
Map – the biggest unit in Marvelmind Indoor GPS. It consists of submaps and forms a full
map of all stationary devices you have. After you build and tune all the submaps and wake
up the mobile beacon, you have to click on Modem icon and Freeze the map. It is the final
stage of building the system. After you freeze the map, tracking will appear.

14

10

11

12

You can Save, Load, Erase map:
Map Settings offer some helpful tools, it is situated in the right bottom corner of the
Dashboard:

-

Save map – saves map as .ini file into Dashboard folder/maps

-

Load map – loads map from .ini format file

-

Erase map – erases map and clears it

Here is the main tutorial video about maps:

-

Help: submaps, service zones, handover zones
Check:

-

8 basic steps from unpacking to autonomous drive/flight

-

Step-by-step guide on how to build complex maps
Detailed explanation of complex map building:
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-

Building submaps: Part 1

-

Building submaps: Part 2

8.2.

Map layers

The map consists of several layers. Each layer can be attached to other.

4) Service zones

3) Beacons and Submaps

2) Floorplan –
plan/scheme/picture of
a floor where you
placed beacons

1) Ether – map grid
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8.3.

The Submap
Submap is a logical unit. A part of the map. It unites beacons to work together in the system.
Submap can contain from 1 to 4 beacons. It can be 1D, 2D, and 3D.
Different types of submaps can be used together. Mix 1D, 2D, 3D as you wish. Map of the
office floor, for example, may contain 1D submap for corridor, 2D/3D submaps for office
rooms. All that submaps will form a big map with coverage you need.
Submaps can contain the same beacons. It makes possible to use 3 beacons instead of 4.
It is very helpful in the IA because we are limited with 8 ultrasonic frequencies.

14

10

12

11

Example 1. Used 3 beacons for 2 2D submaps. Beacon 11 – neighboring. It belongs to
Submap 0 and Submap 1 at the same time. 2 vacant frequencies left:
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10

11

12

13

Example 2. Used 4 beacons for 2 2D submaps. Submap 0 and Submap 1 are independent.
1 vacant frequency left:
Different configurations suit different cases. You can also have submaps with neighboring
beacons and submaps without it on the one map.
Here is a tutorial video about submaps:
-
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Help: using submaps to build large maps

8.4.

Submaps’ service zones
Service zone (or service area) is an area which serve submap. Service zone must be drawn
for any submap you build. It helps to divide tracking between different submaps and outline
the area of responsibility of every submap.
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8.5.

Handover zones
Handover zone is an area which creates when service zones cross. It serves to make a
smooth transfer of mobile beacon from service zone of one submap to another
Handover zone (marked blue)
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10

12

11

How to create Handover zone correctly:
Size of a Handover zone may be different and depends on the mobile beacon’s speed
and system’s update rate. We recommend testing it with the speed of your mobile beacon
mounted on a person/robot/copter. General recommendation is – to make handover
smooth and correct, make sure that your mobile beacon makes at least 4 refreshes in a
handover zone.
Look at the following examples:

-

Example 1: Normal handover zone:
Hedge made 4-5 updates - CORRECT
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11

12

-

\

Example 2: Small handover zone:
Hedge made 2-3 updates – MAY BE NOT ENOUGH
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10

-

12

11

Example 3: Very small handover zone:
Hedge made 1-2 updates – NOT ENOUGH
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10
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11

12

-

Example 4: No handover zone:
Service zones not cross – NO HANDOVER ZONE
CREATED, NO HANDOVER BETWEEN SUBMAPS
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10
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11

12

8.6.

Beacons’ ultrasonic frequencies
Beacons may have different ultrasonic frequencies in the System. It can be used for
different aims and different cases. In IA it’s necessary to have stationary
Please notice that is hardware defined and cannot be just changed via settings
in the Dashboard
Different frequencies can be used:

-

In IA as a basic rule of Inverse Architecture’s functionality

-

In Multi-frequency NIA to increase update rate for multiple mobile beacons

To make it easy to distinguish, stationary beacons with different frequencies in the
Dashboard colored in different colors:
-

19KHz beacon

-

22KHz beacon

-

25KHz beacon

-

28KHz beacon

-

31KHz beacon

-

34KHz beacon

-

37KHz beacon

-

45KHz beacon

Learn more about submaps, service zones and handover zones here: How to create
indoor navigation maps
Learn more about maps lager than 30x30m here: How to build maps lager than 30x30m
Learn more about building of large indoor positioning systems here: How to build large
indoor positioning systems
Here is the main tutorial video about maps:
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-

Help: submaps, service zones, handover zones

-

Check:

-

8 basic steps from unpacking to autonomous drive/flight

-

Step-by-step guide on how to build complex maps

-

Detailed explanation of complex map building:

-

Building submaps: Part 1

-

Building submaps: Part 2

9. Features
9.1.

Licenses
9.1.1. How to activate licenses

Please pay attention that we have different types of licenses: For modem and for
beacon. If you need to activate beacon’s license – connect the specific beacon to the
Dashboard to choose license for that beacon. Connect modem for modem’s licenses.
We added the licenses system. Now, you can order some additional features. It is not
available in the basic Dashboard version, but you can easily purchase it if necessary.
You can see the list on Marvelmind.com -> Products
To order:
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-

Go to Marvelmind.com -> Products

-

Choose features which you want to get (e.g. MMSW0001: 100Hz NMEA0183)

-

Make an order.

-

Pay for the feature (via PayPal or other methods).

-

Order the feature via the Dashboard by providing device’s CPU ID or send us email with the
device's CPU ID:

-

Open Dashboard SW

-

Connect the device you need to order a license to the Dashboard via USB
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-

Go to Licenses → View/activate licenses

-

Choose the licenses which you have purchased.

-

Press Order licenses.

-

Dashboard will generate a text

-

Send generated text to info@marvelmind.com

-

We will generate the license key and send to you via email

-

Place the license key into Dashboard/Licenses folder:

-

Connect device to the Dashboard via USB

-

Go to Licenses → View/activate licenses

-

Choose "Open license key"

-

Choose the license file (be careful if you have licenses for multiple devices,
check CPU ID carefully)

-

The features become activated in the Dashboard.

9.1.2. License MMSW0005 designation in Dashboard
MMSW0005 – one of the most significate license for Marvelmind SW.
Learn more: SW Pack 7.0/7.1 Release Notes
In the previous version of SW (older than 7.200), when license been activated version of
SW changed from 7.0xx to 7.1xx.
From version 7.200 activated license shows in Dashboard as “L”
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-

If license MMSW0005 activated for all devices, it shows L in the window
capture of Dashboard, next to version of Dashboard:

-

If license not activated for one or more beacons in a system, it will be reported
in the right information window:

-

And “L” will be shown next to version of firmware of each beacon with activated
license:

9.2.

Islands feature

To use Islands Feature license MMSW0007 needed and Marvelmind SW from version
7.200 and latest.
This feature allows to make different submaps for each hedge.
How to do this (it’s example with 2 submaps. 4 stationary beacons and 2 mobile
beacons):
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-

Awake all 4 stationary beacons (just Click on it with Left mouse button):

-

Leave 2 of them on Submap0 and move another 2 on Submap1. You will get 2 separate
submaps..

163

-

Move submaps as you wish. Use CTRL and mouse roll to rotate Submap.

-

Awake mobile beacons. It will apeare in a map.
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-

If license activated correctly, with selected modem you can select the “islands” mode and
assign mobile beacons to submaps.

-

Enable Submaps islands

-

When Submaps Islans mode enabled, you can choose submap for each beacon

165

-

Now mobile beacon 12 will be work with Sub1 and beacon 9 will be work with Sub0.

-

Freeze each submap and Freeze map.

-

Ilands settings completed.

9.3.

Dashboard Monitoring Mode

Dashboard Monitoring Mode is a mode which allows you to observe tracking without
any ability to control and modify the system.
Now, you can divide permissions between users for avoidance of accidental change of
any settings and corrupting the system. That is something like safety button.
This is the first version of Dashboard Monitoring Mode. New functionality and
appearance may come with future SW updates
How to enable Dashboard Monitoring Mode:
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-

Click on the “Stream capture” button (It will be renamed in future updates into “Dashboard Monitoring
Mode”)

-

If you try to change settings while Dashboard Monitoring Mode is on, the notification window will
appear:

9.4.

Microphone settings
9.4.1.

Specific Marvelmind devices

For different devices should be turned on different mics.
:Turn on mic by clicking on RX1…RX4
:Change mode of mics by clicking on bottom panel

Below is the picture of microphone settings:

Below are presented settings for different Marvelmind devices:
Badge:

Jacket:

Helmet:
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9.4.2.

Separate Omni-microphone

You can additionally purchase an Omni-microphone for improved performance.
Before buying inform on which device you want to use the Omni-microphone.
On Super-Beacon Omni-mic works in Omni mode on RX3 and RX4. On Super-Beacon-2 Omni-mic
works in Omni mode on RX2 and RX3.

Below is location of different mics on the Omni-mic:

Example of correct settings for Omni-mic on Super-Beacon-2 in Omni mode:

Also, if you want to use specific microphone on Omni-mic you can switch mode to Stereo
and turn on one of the pairs and even one of the mics in one pair.
To turn on of the pairs on Omni-mic click on the box RX2…RX4, depends on which Super-Beacon
you have and which pair you want to have turned on:
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To turn on one of the mic in a specific pair press on a specific box below RX2…RX4 with CTRL:
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9.5.

Restart if modem is disconnected

This feature using to reset beacon when it lost connection with modem.
Follow this steps to switch on this feature.
9.5.1.Connect beacon via USB or radio and expand Misc. settings in settings bar:

9.5.2.Enable restart modem is disconnected option:

9.5.3.Put in a timeout of restart withoout mode in sec:

9.5.4.Restart if modem is disconected feature settings completed.
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9.6.

Geofencing zones

Geofencing zones is a subset of zones which can be created to prevent people crossing
dangerous zones. Zones violations leads to alarm and will be written into CSV-file.
How to create geofencing zone:
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-

Unfreeze map, submap may be frozen

-

Right click on the map -> Zones setup
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-

Left Click on Zone type and choose Geofencing

-

Create a zone using Shift + Left Click and clicking on map, click on point removes it

-

You can tune zone with entering distance and entering time. If zone created, press Save and
close to save zone
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-

After you Save and Close Zones setup window, zone turn to grey. Freeze map

-

Zone created and ready to work. If mobile beacon crosses zone for tuned distance and tuned time,
that violation will be recorded to CSV-file, and hedgehog will be colored red in the Dashboard

9.7.

Geofencing alarm (MMSW0006 license)

SW License MMSW006 activates support for a dedicated pin for geofencing
zone violation. Instead of reading the stream of location data in the protocol, it
is now possible to have just a pin from the 4X4 of Super-Beacon or pins on
the modem or internal pins in the Mini-RX to be automatically switched to “0”
or “1”, on every time reset, when the geofencing zone rules are violated.

Supported hardware:
-

Super-Beacon

-

Modem v5.1

-

Mini-RX

Follow instruction bellow to use this feature:
9.7.1.Connect alarm to your devise according to scheme:
9.7.1.1.
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Geofencing pin scheme for Super-Beacon (when license activated SPI
will not be available):

9.7.1.2.

Geofencing pin scheme for Modem HW v5.1:

9.7.1.3.

Geofencing pin scheme for Mini-RX:

9.7.2.Connect beacon via dashboard or radio and expand Interfaces in a settings
bar:
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9.7.3.Switch on Alarm pin function parameter:

9.7.4.Choose needed alarm pin mode according to a bellow table:
Alarm pin mode

Pin state with alarm

Pin state without alarm

Low level alarm

+3.3V

Z state

High level alarm

0.0V

Z state

9.7.5.Geofencing alarm settings completed.
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9.8.

PPS (Pulse per second) signal

This feature using to get a pulse signal from Super-Beacon every second. Works with
Super-Beacon in NIA only.
To switch on PPS, follow instruction bellow:
9.8.1.Connect a speaker to Super-Beacon 4x4 pinout according to scheme:

9.8.2.Connect beacon via dashboard or radio and expand Interfaces in a settings

bar:
9.8.3.Choose PPS output in PB$ pin function option:
9.8.4.PPS pin settings completed.
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9.9.

Floors feature (FN0011)
9.9.1. The general view
Floor feature allows to build complicated multi-level maps. Every submap correspond
some height, height corresponds to floors.
List of layers (floors)

Show all layers (floors)

Show no layers (floors)

Show all objects (even if they are out of floors’ coordinates)

Active beacons
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9.9.2. Floor Settings
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-

Every floor has its own adjustable height and its own floor plan

-

Right click on the floor area to see an additional menu. There you can change floor’s height. You can
also insert your floorplan for that floor (.png, .jpeg, .bmp, .tiff)

-

Floor 4 and 5 are enabled:
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-

Floor 5 is enabled:

-

Floor 4 is enabled:

9.9.3. Map layers
The map consists of several layers. Each layer can be attached to other.

5) Service zones

4) Beacons and Submaps

3) Floorplan –
plan/scheme/picture of
a floor where you
placed beacons

2) Ether – map grid
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9.9.4. Loading the Floorplan (Substrate)
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-

Right click on the floor -> Load floorplan -> Choose file (.png, .jpeg, .bmp, .tiff).

-

When the picture is loaded, you can drag the beacons to the points where they are actually located.
After dragging two beacons, the picture with beacons will be combined in scale

-

Help video: https://www.youtube.com/watch?v=NHUnCtJIYXc
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-

Right click to a floorplan area, to see an additional menu. Press “Glue floorplan to
ether” to fix a position of floor plan according to map grid.

-

Right click to a beacon, to see an additional menu. Here you can nail beacon to a
floorplan or an ether.

9.10. All hedgehogs update every cycle
To use All hedgehogs update every cycle feature license MMSW 0004 (MF NIA) and
MMSW0008 needed and Marvelmind SW from version 7.200 and latest.
This feature gives simultaneous emission of all mobile beacons in MF NIA (to increase
the update rate in cases where it is known that they won’t interfere with each other).
How to use it:
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-

Make sure that licenses MMSW 0004 and MMSW 0008 activated for all beacons in the
system:

-

Choose modem:
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-

Enable All hedgehogs update every cycle in the settings bar. Left mouse click on disabled
(if feature switched off)

-

Now all mobile beacons update every cycle.

9.11. Filters
Those features help to get more stable tracking and avoid “jumps” of the mobile
beacons.

9.11.1. Spot filtering (for IA only)
This feature using to filter mobile beacons “jumps” in Dashbord.
This feature works from the Modem.
How to use:

-

When Modem connected to PC, choose it in Dashboard and put a tick next to

Spot filtering parameter. This is number of dots, when filter:
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-

Insert Samples number (minimum number of dots when filtering starts):

-

Insert Max. distance between updates (maximum distance between points):

-

Enable Filtering during tracking, for filtering when device moves.

9.11.2. Window of averaging (NIA only)
Sliding window size averaging the position of mobile beacons.
How to use:

-

Choose Modem when it connected to PC and insert Sliding window size in
Window of averaging bar:

Notice, when this feature is on, latency increases.
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9.12. Submap Settings
Every submap has its own settings.
Which beacon will have origin (0; 0; 0) coordinates
Addresses of beacons which are building this submap
3D (X; Y; Z) Tracking mode for this submap
To enable “Vertical submap for stable Z” configuration
Height of hedges for “Vertical submap for stable Z”
Maximum measuring distance limitation mode
Maximum measuring distance between stationary and mobile
Service zone thickness value in meters
Submap X shift value in meters
Submap Y shift value in meters
Submap Z shift value in meters
Submap rotation value in degrees
Plane rotation, X value (“Vertical submaps for stable Z”)
Plane rotation, Y value (“Vertical submaps for stable Z”)
Plane rotation, Z value (“Vertical submaps for stable Z”)
Visibility of stationary beacons (Only displaying setting)
Visibility of service zones (Only displaying setting)

For example, to correspond your submap to a certain floor you need to adjust the height:
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-

Left click on the submap icon to open the settings-

-

Change Submap Z shift value

9.13. Axis rotation feature (FN0002)
9.13.1.

General view

Axis extension enables rotation of the map. There are 90° gaps between views. It helps in
case of multifloor tracking when it is important to have a side view.
There are 3 directions of view:

-

To change view, click on the icon
9.13.2.
Y, X

X, Y
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Examples of view:

Z, X
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9.14. Vertical submaps feature (FN0003)
Vertical submap is a new feature for drone flights or some other specific cases. It gives
the user an opportunity to get solid Z data for vertical movement

-
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Example: The drone flight

9.14.1. How to build vertical submap for stable Z:
9.14.1.1.

For this configuration you need 6 stationary beacons

9.14.1.2.

Place 4 beacons on the ground, facing each other. (make a square,
where the edge points are beacons, looking in the center)

9.14.1.3.

Place two beacons high on a wall

9.14.1.4.

Turn on RX4 only for beacons on the ground and RX4 and RX2 for
beacons on the wall

9.14.1.5.

Build the first submap (horizontal) consisting of all ground beacons

9.14.1.6.

Change Limitation distance to manual and input the value in the
submap’s settings

9.14.1.7.

Freeze and lock it

9.14.1.8.

Build the second submap (vertical) horizontally consisting of two wall
beacons and two ground beacons (neighboring with wall beacons)

9.14.1.9.

Now, freeze it

9.14.1.10. Press axis rotation button
9.14.1.11. Click on the axis you want to rotate your submap along (when you point
the cursor on the axis, it became visible and pink-colored)

9.14.1.12. Enter the corner value (90° usually)
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9.14.1.13. Choose submap 2 and enable “Only for Z coordinates” mode

9.14.1.14. Change Limitation distance value

9.14.1.15. Change views and check the map
9.14.1.16. Wake up mobile beacon
9.14.1.17. Track
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9.15. Submaps feature (FN0004)

Nose shows direction of the
tracking zone

2D submap example
Submaps is a very powerful feature that allows building large maps (full business center,
factory, warehouse with total area of 10,000..300,000 or more) based on smaller
submaps (30..1000m2).
A submap is a part of the map. It includes a subset of used beacons covering part of
the navigation area. Current version of Marvelmind system can include up to 10
submaps. Please also check our help video.

194

9.15.1. Starting submaps
Hedgehogs do not belong to any submap and can move between sub-map areas.
Hedgehogs can be served by multiple submaps at the same time. By default, the map
consists of a single submap (Submap0)
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9.15.1.1.

After adding new beacons to the system (waking them up), they appear
in the first not frozen submap or in Submap0 if all beacons are frozen

9.15.1.2.

Pressing the “+” button will add a new empty submap to the system

9.15.1.3.

Press the button with the submap number (Submap0, Submap1 etc.) select the corresponding submap

9.15.1.4.

In this state, if the modem button is pushed, the list of parameters on the
right side represents some of the parameters of the selected submap, for
example, “Starting beacon trilateration,” “Starting set of beacons,” etc.

9.15.1.5.

The system after adding beacons to the Submap0, adding new submap
and the selection of Submap0

9.15.1.6.

Now we have 4 beacons, all in Submap0 (it can be seen near the table
of distances)

9.15.1.7.

With the submap selected, the context menu of beacons buttons
(available by right clicking) have the functions of adding and removing

the beacons from the submap. In the picture above, we are removing
beacon 3 from Submap0.” Then we switch to Submap1 and add this
beacon to the submap
9.15.1.8.

When the submap is selected, the beacons that do not belong to the
submap are colored gray. In the same way, continue with removing
beacon 10 from Submap0 and adding it to Submap1

9.15.1.9.

Now there are two beacons in Submap1, so this submap is built.
“Submap 0” is built as well. Now we can freeze both submaps

9.15.1.10. Pressing the “freeze map” button when the submap is selected will only
freeze the selected submap. Pressing the “freeze map” button when the
modem button is selected will freeze all submaps.
9.15.1.11. Now we have two good submaps, but they are not correctly located
relative to each other. On the right side exist the parameters of shift and
rotation for the selected submap; they can be filled in by hands. But a
more user friendly way is to drag and drop the selected submap using
the mouse and holding down the CTRL button.
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9.15.1.12. Rotation of submap can be executed by using the mouse wheel. The
mirroring button can also be used; it affects only submaps that are
selected

9.15.1.13. After some movement, rotation, and mirroring of submaps, we can
locate the submaps close to their real relative location
9.15.1.14. Now the system is ready to use; we can wake up and track the mobile
hedgehog
9.15.1.15. In some cases, the hedgehog can be lost between the submaps if this
area is not covered by any of the submaps.
9.15.1.16. Submaps can be removed from the system by using the context menu of
the submap selection button (available with a right click)
9.15.1.17. M1/M2 parameter used for precise superposing submaps which do not
have common beacons. This means that submaps cannot be aligned
automatically

To align submaps:

-
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Build the system like in previous instruction
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-

Put M2 in mode on by clicking the icon. Place the hedgehog near the boundary
between two submaps. You will see 2 red hedgehogs blinking, this is how the
hedge is seen in two submaps

-

To align submaps correctly (CTRL + scroll/drag) against each other, until the red
mobile beacons are fully overlapped

-

Replace hedgehog to 1 or 2 points and repeat replacing submap for better
superposing

-

The next step is to set Service zones, which are zones where tracking is
possible. If a mobile beacon is out of a service zone it cannot be tracked. If you
built a complicated map, you have to make service zones correctly. Service
zones must be crossing in order to provide correct and glide tracking.

9.15.2. How to create a service zone:
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9.15.2.1.

Choose submap (click on the submap icon).

9.15.2.2.

Use SHIFT + Left click on the map to create point.

9.15.2.3.

Use SHIFT + Left click on the point to delete it.

9.15.2.4.

Use Right click on the point and choose “Clear all points” to delete
service zone

9.15.2.5.

Put points around submap, move them to provide service area for
current submap. Service areas will cross each other. If hedgehogs get
lost between two submaps expand the service area.

Learn more:
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-

How to define and edit service zones - How to define and edit service zones,
full instruction

-

Help: submaps, service zones, handover zones - This is a long and detailed
video giving explanations on:

-

What is a submap

-

What is a service zone

-

What is a handover zone

-

How to build larger maps easily and successfully – many practical
advises

9.16. Handover Zones Setting
User must setup handover zones between submaps to guarantee handover quality for
complex maps with multi-floor and similar.
How to setup handover zones:

-

Choose any submap

-

Use Alt + Left Click on the other submap’s service zone border (neighboring)

-

Now, neighboring service zones are colored with green (dark green for chosen submap
and light green for neighboring submaps)

Alt + Left click
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9.17. Paired beacons (FN0005)
Two hedgehogs can be paired and work together as a single beacon without update
rate reduction. In this case you get mot only location, but direction too.

Moreover, each beacon streams out in this mode not only its own location, but direction
where the pair is facing. This feature hugely simplifies autonomous driving and flight.
Here is an updated protocol with the changes.
Please, also check our help video.
How to pair beacons:
9.17.1. If you want to pair beacons via UART then connect Super Beacons with
cable from USART_TX of the Following beacon by address to USART_RX of
the Leading beacon by address and from GND to GND of each beacon (Note:
Look at the pictures below and chapter 8). Only applicable to NIA
Leading Beacon (by address):
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Following Beacon (by address):

9.17.2. If you want to pair beacons via Radio do not connect beacons via anything
and change “Communication in pair” on “via radio” later after point 7.12.6
(Note: If the distance between beacons is less than 1 meter it would be
probably necessary to change in “Parameters of radio” the parameter “Power
of TX” for less value. Otherwise, the signal probably would be too strong). Only
applicable to NIA
9.17.3.

Wake up stationary beacons and freeze the map

9.17.4.

Wake up two hedgehogs which were pre-installed on robot/copter/drone

9.17.5.

Choose one beacon and go to “Pairing mode” parameter and activate

9.17.6.

Write the “Address of paired beacon”, means number of the beacon,

current selected hedgehog is paired with
9.17.7. Now choose location against center in parameters relatively the second
beacon
9.17.8.

Go to “Base of the pair” parameter and write actual distance between

paired hedgehogs. Do the same for 2nd hedgehog
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9.18. Paired microphones
You can also connect additional microphone and turn on “Paired microphones” mode
to get the direction without taking a second beacon (Only for IA).
How to pair microphones:
9.18.1.

7.14.1 Choose beacon in the beacon panel

9.18.2.
additionally

7.14.2 Turn on the microphone which you connected

9.18.3.

7.14.3 Open “Hedgehogs pairing”

9.18.4.
7.14.4 Enter to “Address of paired hedge” address of the
beacon which you are setting up
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9.19. Map settings
Map Settings offer some helpful tools:

-
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Save map – saves map as .ini file into Dashboard folder/maps
Load map – loads map from .ini format file
Erase map – erases map and clears it

9.20. Background color
Starting from v6.200 Dashboard supports background color change.
This is a small feature that helps make tracking look better. If you uploaded a floorplan
and it is white, you can tune Dashboard’s background color to make it suit.
How to choose background color:

-

Load floorplan

-

-
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Right click on the background
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-

Choose color and press “OK”

-

Color applied. Now, background matches floorplan

9.21. Hedge color change (FN0006)
If you have multiple mobile beacons, you can give each one its own color to make them
recognizable on the map

How to change hedgehog color:

-
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Right click on the hedge in the list of devices -> Setup color

-

Choose any color which suits you and press OK

-

Now, the hedgehog and its tracking path will be colored

-
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9.22. Payload streaming (FN0007)
Mobile beacon streaming user payload to modem. See the table with speed vs. payload
-

All measurements were made with update rate setting 16 Hz. Real update rate
is limited by distance, radio profile and payload data size.

-

Additionally, with the MMSW0005 license the hedgehog payload is recorded in
CSV format.

System configuration

Radio profile, kbps

User payload Real
data
per update
cycle, bytes
rate, Hz

2 stationary beacons,
3 meters maximum distance

500 (FEC)

0
32
0
32
0
32
0
32
0
32
0
32
0
32
0
32

153 (FEC)
38.4 (FEC)
38.4 (no FEC)
4 stationary beacons,
11 meters distance

500 (FEC)
153 (FEC)
38.4 (FEC)
38.4 (no FEC)
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16
16
16
16
9
8
14
13
14
14
12
12
6
6
9
9

User
payload
maximum
data rate
(bytes per
second)
0
512
0
512
0
256
0
416
0
448
0
384
0
192
0
288

9.23. IMU feature (FN0008)
This function allows to increase data update rate received from ultrasound beacon with IMU due to
sensor fusion up to 100 Hz, using inertial sensors (accelerometer, gyroscope).

9.23.1. Setup IMU feature
Accelerometer calibration
Required:

-

Starter set
Hedgehog with IMU
SW and firmware version 5.85 or newer
Ultrasound Update rate 4Hz or higher

Before you start use the feature check whether accelerometer has been calibrated

-

211

-

Check if hedge was not calibrated before. Was damaged or fall down
Put hedgehog on a flat surface (antenna directs up) and connect to your PC. Run the
Dashboard
Go to view => Accelerometer calibration in open window click autofill and clear table.

-

After all values will refresh. Next, click Pause (shift + space)

Then take the beacon (hedgehog) and tilt it to each side towards the ground (about 6
times). Rotate a little. You need to achieve x y z values:

-

When antenna directs down z ≈ - 1000 => antenna directs up z ≈ 1000

-

So, one of the axis values always will be - + 1000. Others ⩽ 10 (preferably less 10,
but 25 is also permissible)

-

Every time before calibrating the hedgehog click Pause

-

Accelerometer calibrator will choose the best value for each axe. At the end click
Calibrate and close the window

-

Calibration is needed to determine g value for each accelerometer axe

Start the system:
Setup the system as usual. It is described in paragraph Setting up the system.
After the ultrasound tracking has started, select the hedgehog in the Dashboard, go to
menu Interfaces (on the right) and enable Processed IMU data. After that, it is
recommended to bring the hedgehog to real estate and press the ZERO IMU button (rightbottom) for additional sub-calibration of the gyro. After 5 seconds the hedgehog will begin
streaming the processed IMU data.
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9.23.2. Using Data in the Python Library Example
Description of the protocol for streaming data: (link)
To work with data, you need to use some ready-made library, or develop your own
software tools that can work with the described protocol.
Our company provides ready-made libraries for working with IMU in the following
languages:

-

python (link)
c ++ (link)
java (link)

An example with 3D imaging of a path on IMU with a frequency of 100Hz in real time,
here: https://marvelmind.com/pics/marvelmind-imu-tracker.zip
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9.24. IMU axis positioning
Super-Beacon IMU axis positions

HW v4.9 IMU axis positions
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Mini-TX IMU axis positions

Mini-RX beacon IMU axis positions
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9.25. Player feature (FN0009)
This function is used to view the distance passed, the flight of the copter, etc. The player
displays statistics on the maximum and average speed, the path traveled.
Starting with Dashboard v6.240, log files writes in .csv format

How to use Player:

-

Go to File=>Player

This is how the starting player menu looks like
Select log – opens save log file
Play – launch the playback
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-

Click Select log button and choose the file

-

Now log is loaded. Important: for recording log file click Save map for saving all the
beacons locations and attaching all the beacons to the log. Log file also created while
Freeze map pressing.

At the top of the player you can see 7 outputs:

Currently playing time

Select log file
Start of Log time
End of Log time
Start of Playback
Play/pause button

End of Playback
Close player button

Limited area - distance between black triangles under slider. You can move triangles and
zoom, place cursor on the slider + mouse wheel. Triangles limit the area in which player
works and the statistics is calculated
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9.26. Real-time player feature (FN0010)
Real-time player is a feature, which makes the tracking path smoother. As far as it looks
backward and forward it certain latency based on the selected parameters.

-

Real-time player turned on by default

-

You can turn it off if you need less delay

You can tune it whether you need:

-

Backward – amount of dots which player ‘looks’ backward to provide smooth tracking

-

Forward – amount of dots which player ‘looks’ forward to provide smooth tracking
Tracking examples:

-
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Real-time player turned off

-
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Real-time player turned on

9.27. CSV format
Current Dashboard version supports additional timestamp. See the attached
screenshot, the UNIX time in milliseconds is the first value.
In each line comma separated values, CSV:

-

- UNIX time in milliseconds (time since 1970.01.01)
- time from previous record in milliseconds
- time from running dashboard in milliseconds
- address of hedgehog
- X coordinate of hedgehog, meters
- Y coordinate of hedgehog, meters
- Z coordinate of hedgehog, meters
- address of stationary beacon
- raw distance from hedgehog to stationary beacon, meters

The last pair (beacon address, distance) is repeated n times equal stationary beacons
quantity in the system.
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10.

Interfaces
Indoor “GPS” system supports many external interfaces that can feed measured
location data to an external system (robot, copter, VR, etc.).
There are two different ways to obtain the mobile beacons’ location data from the
system:

-

From the mobile beacons
- Each mobile beacon knows its own position and does not know the positions of the
other mobile beacons

-

From modem/router
- Knows position of every mobile beacon in the system
Data from the mobile beacons and from the modem can be obtained at the same time, if
necessary
Starting from software version v7.200 real-time timestamps are enabled by
default. If you need an old streaming format with local timestamps for
compatibility with older software, you can disable this option in the device settings
in the dashboard:

A list of the supported interfaces is shown below.
More information on the interfaces can be found here:
https://marvelmind.com/pics/marvelmind_interfaces.pdf
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10.1. Super-beacon external interface pinout top view
4x4 pinout for Super-Beacon:

4x4 pinout for Super-Beacon-2:
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10.2. Beacon HW v4.9 external interface 4x4 pinout top view
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10.3. Modem HW v4.9 external interface pinout top view
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10.4. Mini-RX internal solderable pinouts (for experienced users only)
Use it only if you sure that you can solder it correctly
Do not forget to turn off the beacon with DIP-switches
If you solder bad and kill the beacon, Marvelmind team won’t be responsible for it
To get UART data streaming from beacon Mini-RX, you must solder to the pins on the
board.
*BAT - you can disconnect internal battery and supply here an external power source of
3.5V-5.2V to the point with current up to 50mA
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11.

Advanced system settings and optimization
Start using advanced settings only when you are confident with the system.
If you run into trouble, connect the beacon or modem to the PC via USB and use the
DEFAULT button. It will upload “factory settings” to the board while keeping the device
address untracked.
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11.1. Radio Profiles compatibility
In this section we present different HW versions of different products
38 Kbps

100 Kbps

400 Kbps *

Modem HW v4.9

Supports

Supports

Doesn’t Support**

Supports

Modem HW v5.1

Supports

Supports

Supports

Supports

Modem HW v5.1-3

Supports

Supports

Doesn’t Support**

Doesn’t Support**

Super-Modem

Supports

Supports

Supports

Supports

Super-Modem-2

Supports

Supports

Supports

Supports

Super-Modem-3

Supports

Supports

Doesn’t Support**

Doesn’t Support**

Beacon Mini-RX

Supports

Supports

Supports

Supports

Beacon Mini-RX-2

Supports

Supports

Supports

Supports

Beacon Mini-RX-3

Supports

Supports

Doesn’t Support**

Doesn’t Support**

Super-Beacon

Supports

Supports

Supports

Supports

Super-Beacon-2

Supports

Supports

Supports

Supports

Super-Beacon-3

Supports

Supports

Doesn’t Support**

Doesn’t Support**

Industrial Super-Beacon

Supports

Supports

Supports

Supports

Industrial Super-Beacon-2

Supports

Supports

Doesn’t Support**

Doesn’t Support**

Industrial Super-Beacon-3

Supports

Supports

Doesn’t Support**

Doesn’t Support**

Beacon HW v4.9

Supports

Supports

Doesn’t Support**

Supports

Beacon Mini-TX

Supports

Supports

Doesn’t Support**

Supports

*400 kbps is used in Japan instead 500 kbps
**Won’t be available, because of specific radio chip configuration
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500 Kbps

Examples of different configurations
Starter Sets consist of different devices, so you check what types of devices you have
and it will depend on which radio profiles you can use
Example 1 – Modem HW v5.1 and Super-Beacon-2

38 Kbps

100 Kbps

400 Kbps *

500 Kbps

Modem HW v5.1

Supports

Supports

Supports

Supports

Super-Beacon-2

Supports

Supports

Supports

Supports

From this table we can see that in this configuration you can use all profiles, because
both devices support them.

Example 2 – Modem HW v.5.1 and Super-Beacon-3

38 Kbps

100 Kbps

400 Kbps *

500 Kbps

Modem HW v5.1

Supports

Supports

Supports

Supports

Super-Beacon-3

Supports

Supports

Doesn’t Support

Doesn’t Support

From this table we can see that in this configuration you can use 38 kbps and 100kbps
radio profiles, because Super-Beacon-3 doesn’t support 400 kbps and 500 kbps (Won’t
be available, because of specific processor configuration).

Example 3 – Modem HW v.5.1-3 and Beacon Mini-RX-3

38 Kbps

153 Kbps

400 Kbps *

500 Kbps

Modem HW v5.1-3

Supports

Supports

Doesn’t Support

Doesn’t Support

Beacon Mini-RX-3

Supports

Supports

Doesn’t Support

Doesn’t Support

From this table we can see that in this configuration you can use 38 kbps and 100 kbps
radio profiles, because Modem HW v5.1-3 and Beacon Mini-RX-3 don’t support 400
kbps and 500 kbps (Won’t be available, because of specific processor configuration).

Example 4 – Modem HW v.5.1, Super-Beacon-2 and Beacon Mini-RX-3

38 Kbps

153 Kbps

400 Kbps *

500 Kbps

Modem HW v5.1

Supports

Supports

Supports

Supports

Super-Beacon-2

Supports

Supports

Supports

Supports

Beacon Mini-RX-3

Supports

Doesn’t Support yet*

Doesn’t Support

Doesn’t Support

From this table we can see that in this configuration you can use 38 kbps and 100 kbps
radio profiles, because Beacon Mini-RX-3 doesn’t support 400 kbps and 500 kbps
(Won’t be available, because of specific processor configuration).
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11.2. Wi-Fi settings for Super-Modem
You can use Wi-Fi for coordinate streaming to other PC. In this chapter we explain how
to do that.

11.2.1. Wi-Fi settings menu in Dashboard
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-

When Super-Modem connected to PC via USB, expand “Wi-Fi/UDP settings” in settings
bar.

-

Enable Wi-Fi

-

Insert Wi-Fi network name and Wi-Fi network password of your wireless connection and
press “Write” button
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-

After this, “Wi-Fi/UPD settings” bar turns to green and shows your network name.

-

Insert UDP destination IP address and UDP destination port of device to which you will
stream coordinates and press write button.

-

Wi-Fi settings completed.

11.2.2. Static IP
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-

When Wi-Fi enabled, enable Static IP and wait around 10 sec:

-

Enter IP address in IPv4 format (An IPv4 address has the following format: x .
x . x . x where x is called an octet and must be a decimal value between 0 and
255.) and IP address of router that using for Wi-Fi connection. Press Write
button:
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-

If everything done correctly, Own IP address will change:

-

Static IP settings completed.

11.3. Building big maps in Inverse Architecture (IA)
This chapter is applicable only for Inverse Architecture

11.3.1. Introduction
In this chapter we described building big maps in IA. It has differences from classic NIA
map building because we have more than 1 ultrasonic frequency, and we need to make
sure that they do not interfere with each other. Please, read carefully.
A map is a system unit that includes submaps, stationary beacons and service zones
within which positioning of mobile beacons is ensured by ultrasonic signals from the
stationary beacons of this submap.
Handover zone (marked blue)

Map

Mobile beacon

Service zone Submap0

Service zone Submap1

14

Stationary beacon
10

11

12

Submap0 tab
Submap1 tab
Submap0 (beacon 10 + 11)

Submap1 (beacon 11 + 12)

The main parameters of a submap are its size, frequencies and TDMA position of
stationary beacons, by which mobile beacons can not only be positioned, but also
determine in which submap the mobile beacon is located.
Check before start:
8 basic steps from unpacking to autonomous drive/flight
Step-by-step guide on how to build complex maps
Detailed explanation of complex map building:
Building submaps: Part 1
Building submaps: Part 2
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11.3.2. TDMA sequence:
As far as we have only 5 ultrasonic frequencies, when we build big maps and when
ultrasonic signals may interrupt each other, we must use TDMA. In this case submaps that
cannot be used together will work alternately. Please notice that update rate falls by a
multiple of TDMA sequence. If you have 8Hz basic update rate without using TDMA, 3
TDMA sequences will make it 8/3Hz.
TDMA is the mode of sequential radiation, when for each stationary beacon the
number of the cycle in which it should emit and the number of cycles of radiation
after which these numbers are repeated is set
We have 3 TDMA types:

-

Type 1 - TDMA as NIA multiple beacons’ working algorithm

-

Type 2 - Full-overlapping TDMA (For better coverage in 2D). See more on
TDMA chapter

-

Type 3 - TDMA for huge IA maps building (described below)

For building huge maps in IA, we need TDMA Type 3.

19kHz(j0, T1)

Example 1:

31kHz(j0, T1)

Submap0

45kHz(j0, T1)

19kHz(j0, T2)

Submap1

Submap2

31kHz(j0, T1)

45kHz(j0, T1)

31kHz(j0, T2)

Submap3

45kHz(j0, T2)

Submap4

The same frequency sets
The same jitter codes for beacons
Different TDMA sequence
T\s

Submaps differ - CORRECT
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Submap4

31kHz(j0, T2)

Submap1

45kHz(j0, T2)

19kHz(j0, T2)

Submap5

-

Example 2:

For example, a 100x100 meter map in open-spaced area consists of 55 submaps,
the vertical rows of submaps are the same, but operate in different TDMA loops
using TDMA type 3. In this example we used different colors for every TDMA
position in sequence. TDMA 1(red) submaps emit first, TDMA 2(green) submaps
emit second, TDMA 3(blue) submaps emit third:
TDMA 1

TDMA 3

TDMA 1

TDMA 2

TDMA 3

TDMA 1

TDMA 2

TDMA 3

TDMA 1

19kHz

TDMA 2
19kHz

19kHz

19kHz

19kHz

19kHz

19kHz

19kHz

19kHz

19kHz

TDMA 2
19kHz

SM0

SM5

SM10

SM15

SM20

SM25

SM30

SM35

SM40

SM45

SM50

31kHz

31kHz

31kHz

31kHz

31kHz

31kHz

31kHz

31kHz

31kHz

31kHz

31kHz

SM1

SM6

SM11

SM16

SM21

SM26

SM31

SM36

SM41

SM46

SM51

45kHz

45kHz

45kHz

45kHz

45kHz

45kHz

45kHz

45kHz

45kHz

45kHz

45kHz

SM2

SM7

SM12

SM17

SM22

SM27

SM32

SM37

SM42

SM47

SM52

19kHz

19kHz

19kHz

19kHz

19kHz

19kHz

19kHz

19kHz

19kHz

19kHz

19kHz

SM3

SM8

SM13

SM18

SM23

SM28

SM33

SM38

SM43

SM48

SM53

37kHz

37kHz

37kHz

37kHz

37kHz

37kHz

37kHz

37kHz

37kHz

37kHz

37kHz

SM4

SM9

SM14

SM19

SM24

SM29

SM34

SM39

SM44

SM49

SM54

25kHz

25kHz

25kHz

25kHz

25kHz

25kHz

25kHz

25kHz

25kHz

25kHz

25kHz

Moreover, the map consists of 6x11 = 66 stationary beacons, i.e. 11 beacons of each
of the frequencies combined into submaps: 19-31kHz, 31-45kHz, 45-19kHz, 1937kHz, 37-25kHz.
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11.3.3. TDMA Type 2 - Full-overlapping submaps
The steps below describe how to run IA with TDMA feature, which helps to improve the
tracking quality in complex situations.

Suitable for IA only. Use IA Software
Stationary beacons should have different frequencies
When you work with two TDMA submaps, update rate reduces twice.
11.3.4. Mount stationary beacons in according to the TDMA chapters in
Placement manual.
11.3.5. Wake up beacons included in Submap0. Enter the values in the table
“distance between beacons”, Freeze it. If necessary, set the shift, rotation,
height, etc. Draw a service zone (More info: Submaps feature description).
11.3.6. Wake up beacons included in Submap1. If the submap uses beacons
from other submaps, you must add them to the current one. Draw a service
zone, fully crossing with Submap0’s service zone.
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11.3.7. If submaps with the same set of frequencies intersect, it is necessary to
use TDMA. (This is the mode of sequential radiation, when for each
stationary beacon the number of the cycle in which it should emit and the
number of cycles of radiation after which these numbers are repeated is set)
For example, in the room there are beacons 19kHz, 45kHz and two 31kHz
and submaps respectively 19kHz+31kHz and 31kHz+45kHz both include
beacon 31kHz, therefore for all beacons the length of the TDMA sequence is
set to 2, while the position in the TDMA sequence for beacons in
19kHz+31kHz submap is set to 0, and for beacons in 31kHz+45kHz submap
is set to 1. As a result, the radiation of beacons in submaps occurs
sequentially, first 19kHz+31kHz submap, then 31kHz+45kHz submap. You
can also use absolutely the same set of frequencies in submaps (Submap0 =
19kHz+31kHz, Submap1 = 19KHz+31KHz)

11.3.8.

Activate mobile beacons.

11.3.9.

Freeze the entire map. Now, you can work with it.

11.3.10. If you have any jumps, that can mean that you have wrong submaps’
positions. Unfreeze all and try to move it until you get their correct positions.
TDMA modes:
System supports two modes of TDMA:

-

Mode 1 (Adaptive): Hedge determines which submap sees it better at the
moment, and tracks in it. It can give better tracking, but in bad conditions, it
may cause mistracking

-

Mode 2 (Classic): Hedge tracks in two submaps one by one. It can give solid
50/50 tracking in conditions where one submap can’t see the hedge at all. After
measurements, Real-Time Player makes tracking smooth, filtering out
mistracking

Each mode has its pros and cons. Try them both and choose the best suiting for
your case.
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How to change modes:
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-

Choose hedge

-

Go to Ultrasound -> TDMA mode

-

Left Click to change

11.4. Increasing update rate
The update frequency is affected by 2 main parameters:
1) Radio profiles
2) Room dimensions (tracking areas)
If you need to tune the update rate of tracking, do the following:
1) Radio profiles:
There are 3 radio profiles available: 38kbps, 153kbps, 500kbps:

-

38kbps is the slowest, but is able to cover a greater distance

-

153kbps - average speed, overcomes the average distance (default)

-

500kbps is the fastest, but works at a shorter distance

Accordingly, to raise the update rate, we recommend switching to 500kbps.
How to:

-

In the settings bar of each device in the system (including modem), change the
Radio profile parameter to 500kbps (or any you need). It is situated in the
Dashboard, on the right side of the Dashboard screen.
Tip: Change the beacons’ profile before modem’s, in order not to lose your
beacons. It allows you to do it remotely

2) Room dimensions (tracking areas)
Update rate is also having linear dependence with tracking distance (distance
between stationary and mobile beacon):

-

Longer distance – lower update rate

-

Smaller distance – higher update rate

If you have room 10x10m, change maximum distance setting. This will limit the
system to the maximum measurement distance.
How to:

-

Go to the submap settings (click on the submap icon)

-

Change maximum distance value in meters (20 is a default)
Tip: Do not enter very small value, use 1-2 meter’s margin. Also, do not use 20
meters if you have small tracking area. Tune carefully.

Learn more here: How to increase location update rate?
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11.5. Reducing location update latency
Exact latency depends on many factors:

-

IA or NIA

-

From modem or from the beacon

-

IMU sensor fusion or regular ultrasonic only

-

Radio profile

-

Realized update rate

-

Any sort averaging or Real-time player enabled or not

The range is:
~ 12ms for data from a mobile beacon via USB with IMU fusion enabled and not
averaging at all
~ 150ms with 30m-submap and update rate in ultrasonic of 7Hz and not averaging
~ 2 seconds with the same settings as in (b), but Real-Time Player with settings 16, i.e. it
takes into account up to 16 previous readings before giving out the new one
What affects delay:

-

Real Time Player in the Dashboard (For NIA)

-

Real Time Player in hedge (For IA)

-

Window of averaging and Distance filter settings in modem (For NIA)

-

Prefiltration coefficient and Ultrasonic filtering settings in hedge (For IA)

How to decrease latency:
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-

Turn off the Real-Time Player (works for IA and NIA)

-

Change the Window of averaging and Distance filter settings value to 0 (For
NIA):

-

Choose Modem -> Window of averaging (in the right tab) -> Enter 0 value

-

Choose Modem -> Distance filter (in the right tab) -> Enter 0 value

-

Change the Prefiltration coefficient and Ultrasonic filtering settings value to 0
(For IA):

-

Choose your mobile beacon. Go to Ultrasound -> Prefiltration coefficient ->
Enter 0 value

-

Choose your mobile beacon. Go to Ultrasound -> Ultrasonic filtering ->
Enter 0 value

-

Complete. Latency reduced

Learn more here: How to increase location update rate?
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11.6. How to Place Beacons
Avoid placing beacons on long sound-conducting objects
This is very rare but may happen under some special circumstances.
The best practice is to place beacons (stationary and mobile) in places that would not
result in the transfer of ultrasound energy from the beacon’s board/case directly to the
place it is attached via a medium other than air. For example, solid attachment of a
beacon to a long horizontal metal tube may result in the following:

-

Sound emitted from the beacon propagates directly to the metal tube.

-

Propagation losses inside metal are much smaller than in the air Moreover, the tube
may act as a low-loss waveguide.

-

If the tube is solid enough and long enough, there may be an unusual effect where
the receiving beacon receives the signal sooner than expected, i.e., sooner than the
distance divided by the speed of sound in air. That happens because the speed of
sound in metal is much higher than the speed of sound in the air. The ultrasound
signal may even look stronger than the real signal propagated through the air due to
the lower amount of losses of ultrasonic in metal than in the air.

-

It is good practice to place beacons on something relatively soft or something that
does not conduct sound.

Place beacons in a way that provides the proper ultrasonic coverage. It must be
one beacon in the line of sight of minimum 2 beacons. Try to locate them under
ceilings to avoid shadows, walls etc.

-

Optimal settings for stationary beacons in small and big rooms.

-

Use 30–50 ultrasonic pulses for larger places and the default 5 pulses for smaller
places.

-

Optimal settings for noisy environment.

There are several ways to reduce impact:
-

Mobile beacons can be placed very close to the source of noise without
harm, but stationary beacons should be placed further from the noise
because they are receiving the ultrasound, whereas the mobile beacon is
emitting the ultrasound.

Learn more about placing of the beacons here: How to increase accuracy of precise
indoor positioning system
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11.7. Using the Oscilloscope
-

Monitor the ultrasonic signal from one beacon to another

-

Use Dashboard => View => Oscilloscope to monitor ultrasonic signals from one beacon
to another

-

It is a very powerful tool, because it also gives information on the background noise, level of
the signal, echo, etc. With this tool, it is easy to set up the proper ultrasonic threshold on the
Dashboard.
Type the reference
beacon number
and press Enter

Echo
External noises look
similarly. Thus,
choose the
ultrasonic
threshold below
this value, for
example, -500 to
-2000

Ultrasonic
signal
front
Trigger (red
line)
Emittion
counter
Choose the
beacon
to test
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11.8. Proper Ultrasonic Signal Detection
This chapter mostly related to HW v4.9 beacons. Super-Beacons, Industrial SuperBeacons have high-power digital microphones for noise filtering and proper signal
detection. Anyway, if you have problems with signal detection, read this chapter no
matter which beacons do you use
These recommendations suitable only for NIA
Marvelmind Indoor Navigation System uses proprietary multi-frequency for ultrasonic
signal and employs additional filtering to combat external noise. This also makes the
system rather immune against the “usual suspects.” However, if the external noise is
too strong, its source is too close, or it’s emitting a strong signal on frequencies close to
19, 25, 31, 37, 45kHz or white noise, the system functionality can be affected.
When external noise is high, identify the source. Usual sources include:

-

Ultrasonic-based volume or movement detection alarm systems

-

Other robots using ultrasonic

-

Parktronics

-

Sources of very strong white or impulse noise (air guns, air press, cutters,
vacuum cleaner, etc.)

-

Rotors of drones/copters

The best things to do in this case:

-

Identify the beacons that are affected. Usually, they are those that are the
closest to the source of noise. Try to reposition them

-

Manually reduce the gain of the affected stationary beacons so that the signal
from the mobile beacon would have a 1000–1800 amplitude. That would give
the best signal-to-noise ratio. Don’t make the gain too high. The noise will be
amplified, but the desired signal will be saturated and signal-to-noise ratio will
be poor

-

Input distances between beacons manually. More information – Table of
distances

The gain settings may be very non-linear. There is almost no change at 4000 to
3000. But around 2500, the gain starts reducing very quickly (1200 – for some HW
versions). By setting the gain manually, it is possible to find the optimal gain to obtain
the highest signal to noise ratio so the system can work even in very challenging
external conditions.
When the map is formed, only the mobile beacon is emitting, whereas stationary
beacons are not. Thus, it does not matter how close the mobile beacon is to the
source of the noise. However, it matters how close the stationary beacons are to
those sources. Select the positions of the stationary beacons accordingly - place
them further away from the noise sources.
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11.9. Using hedgehog.log file
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-

The system automatically records all measured positions in the hedgehog.log file that is
stored in the same folder as the Dashboard.exe file

-

The data is written in csv format; each line describes the position of one of the hedgehogs
at a certain moment

-

The line format is described here.

11.10. System Accuracy Evaluation
Accuracy of distance measurement:

-

Marvelmind navigation system can measure distances between beacons with
accuracy of +/- 2cm if correct ultrasound speed is used.

-

The ultrasound speed depends on several factors: temperature, pressure, and
humidity. Other factors have an insignificant effect.

-

The main factor is temperature. In temperature range of -20…+50 °C the speed of
ultrasound changes on about 0.6 m/ (s* °C). It gives distance error about (0.6 / 340)
*100% ~ 0.17%/ °C. So caused by incorrect temperature setting absolute error of
distance measurement is 0.17% of real distance between beacons. For example, with
distance 30 meters and 5 °C error, this gives 0.85%*30 ~ 0.25 meters’ error.
Marvelmind system allows to setup temperature of air in the system settings.

Accuracy of position measurement:

-

Marvelmind system uses trilateration algorithm to calculate position by distances. The
inaccuracy of position calculation is related to inaccuracy of distances measurement
and to geometry of relative location of stationary and mobile beacons

-

Basic trilateration formulas are given in this article:
https://en.wikipedia.org/wiki/Trilateration

-

As you see, the position of mobile beacons X, Y, Z is calculated from positions of 3
stationary beacons which are set by values of d, i, j. One of the beacons was shifted
to (0,0) position to simplify formulas in the article. In formulas for X, Y we see d and j
in denominators. This means that with low values of d and j small error of this value
can cause significant position error

-

Please see the picture of the beacons in the article - in more simple words, in means
that if one of three beacons is close to line connecting other two beacons, it gives
increased inaccuracy of locating mobile beacon

For example:

-

assume d= 10, i= 5, j= 0.1, r1= 7, r2= 7, r3= 4.8

-

We get x= 5, y= 2.4375, z = 4.25

-

If we suppose that j=0.101 (0.1 cm error), we receive x= 5, y= -0.06, z= 4.89

-

You see very large Y error

Another example for Z. Assume mobile beacon is relative close to plane of stationary
beacons:
- d= 8, i= 4, j= 6, r1= 5.02, r2= 5.02, r3= 3.01

-

This gives X=4, Y= 3.01169, Z= 0.36

-

If we suppose r3= 3.0 (1 cm error), we receive X=4, Y= 3.016, Z= 0.44. Error
on Z is about 8 cm

Also, with r1= 5, r2= 5, r3= 3, Z will be 0. As you see, low change of distances causes
large change of Z value near the plane.
Learn more about accuracy here: Absolute vs. relative accuracy
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11.11. Calibration of the accelerometer

To calibrate an accelerometer on your beacon with IMU, you can do the following steps:
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-

Connect the mobile beacon via USB to the Dashboard

-

Make sure that the beacon has IMU on board: open View / Accelerometer menu
and view / gyro data. In the presence of IMU graphics in these windows should
display the angular velocity and acceleration when moving the mobile beacon (turn it
in hands).
Close the window of the accelerometer and gyro data

-

Open the calibration window: View / calibrate the accelerometer

-

When calibrating, it measures the data of the free fall (gravity of the Earth)
corresponding to each of the three axes X, Y, Z. The initial ones from these
calculations remember the correction shifts indicated in the table as "Zero" and the
correction factors indicated as "K"

-

The switch at the right bottom of the window should be in the AutoFill position

-

Before starting the calibration, click the Reset button at the top of the window zeroing the current calibration results

To calibrate: slowly, without jerking, manually turn the beacon in each of the 6 positions
and keep it still for 1-2 seconds:
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-

The starting position - the beacon lies on the table; the antenna is pointing
upwards (calibration Z +)

-

The beacon is turned upside down, the antenna pointing down (calibration Z-)

-

The beacon is on the end, the sensor RX1 is pointing towards the table
(calibration Y +)

-

The beacon rests on the end, the RX3 sensor points toward the table
(calibration Y-)

-

The beacon rests on the end, the RX2 sensor is directed towards the table
(calibration X +). In order not to interfere with the USB connector, the beacon
can be placed on the edge of the table, so that the cable hangs down

-

The beacon rests on the end, the RX5 sensor points toward the table
(calibration X-)

-

In each measurement, the readings of the accelerometer are corrected by Zero and
K.
At the end of the measurement of 6 points 7.1 ... 7.6, in the serviceable
accelerometer Zero should be close to zero, and K close to 1, see the screenshot.
If not - check if you forgot any of the points 7.1 ... 7.6.

-

To save the results, click Calibrate.

11.12. Settings to obtain correct north direction
In some cases, it is necessary to obtain a correct north orientation of the map for NMEA
output from Marvelmind system. For example, when using a Marvelmind mobile beacon
as the navigation data source for Pixhawk installed on a copter, correct north is required
for correct yaw control of the copter. The Marvelmind system cannot determine north
automatically, so the user should make corrections after building and freezing the map.
It can be done in one of two ways:

Option 1

-

Rotate the Marvelmind map using the dashboard as shown on the screenshot below

-

You can also view the video:
https://www.youtube.com/watch?v=AsYXrtg7aVU&feature=youtu.be

Option 2

-

Enter the angle correction (the angle shown on screenshot) on the Pixhawk side from
the Mission Planner of APM Planner

-

Refer to the parameter "BCN_ORIENT_YAW":
http://ardupilot.org/copter/docs/parameters.html?highlight=bcn_orient_yaw
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11.13. Communication of Pixhawk with Marvelmind mobile beacon
The Marvelmind mobile beacon can be connected to Pixhawk (and to any other
hardware or software that inputs GPS according to the NMEA0183 protocol).
The mobile beacon can send GPS data via UART and USB (virtual UART)
interfaces. For further explanation, please check out this document.
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11.14. Sending path to robot
You can send the path for your robot via Dashboard

-

The dashboard sends request to modem via USB.

-

Procedure of sending these requests in dashboard is shown on second screenshot.

-

This format of request is described in section 8 of modem protocol:

-
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Modem transmits data to the hedgehog via radio, using our proprietary protocol
https://marvelmind.com/pics/modem_usb_protocol.pdf

-

the hedgehog communicates with robot via UART. Hedgehog sends data according to
section 2.3.1 of this protocol:

-

https://marvelmind.com/pics/marvelmind_beacon_interfaces.pdf

-

The robot should confirm receiving data by response packet shown in section 2.3

-

This communication on the robot side is implemented in the Arduino example on our site.
As you can see in the protocol, robot should not request the waypoints, the hedgehog will
send the waypoints when they will be transmitted from dashboard. But robot should
confirm receiving each waypoint by this packet:

-

[0x03,0x47,0x01,0x02,0x00, <2 bytes of checksum>]

Learn more about Robot Boxie in Marvelmind Boxie Operating Manual
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How to send a path:
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1)

Set up the Marvelmind Indoor “GPS” system.

2)

Turn on Boxie and wait for 1 minute

3)

Configurate paths and points (Use Shift+Left mouse button click to create
point, click on point – to remove):

4)

Press “Run”. Robot will follow the path that you draw:

5)

If you put a tick on “Run forever”. Robot will move till you press stop button in
control panel or before obstacle detected:

11.15. Proper ultrasonic coverage
The single most important requirement for the system to work well is to have proper
ultrasonic coverage
Each sensor has an ultrasonic beam of ~90 degrees. Outside of that range, the emitting
power and sensitivity drops quite rapidly. From the left, right, or back of the ultrasonic
sensor, the signal is highly attenuated. Thus, it is crucial to provide proper ultrasonic
coverage for the area where the robot will be moving.
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-

It is also very important to provide proper ultrasonic coverage to the stationary
beacons when the map is being formed

-

Mobile beacon (“hedgehog” or “hedge”) is designed to be placed horizontally

-

The mobile beacon has four horizontal and one vertical sensor, each covering its own
sector. Together, they cover 360 degrees horizontally and 180 degrees in the upper
hemisphere. The lower hemisphere is highly attenuated, so don’t expect ultrasonic
coverage in that area

-

It is advised that the mobile beacon be placed as high as possible on the robot if the
stationary beacons are above the mobile beacon. This minimizes shadows from other
objects, people, etc.
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-

Example of proper positioning of the mobile beacon can be found here:
https://youtu.be/PFgNPkLGCDk

-

The beacon is placed horizontally and above other objects that can cast a shadow on the
stationary beacons

-

Keep the radio signal’s strength under control

-

The RSSI (Dashboard => right menu) of any beacon/modem must not be higher than 25dBm. Otherwise, the system may malfunction

-

It is recommended the distance between the modem and beacons be no less than 0.5–
1m. Beacons can be placed as close to each other as needed. If a beacon is extremely
close to the modem, disconnect the antenna from the beacon. Monitor the Received
Signal Strength Indicator (RSSI). It must be in the range of -25 to -70dBm. An RSSI of
less than -70dBm will work too, but packet losses may start occurring. The quality of the
radio connection very much depends on external interference as well because the used
band is ISM (either 915MHz or 433MHz) and there are numerous co-existing systems.

-

Use 30 - 50 periods (pulses) in settings instead of the default 5. Select:

-

Ultrasound settings => Number of periods

-

When you have large errors in position estimation (more than a 1m inaccuracy), use the
embedded Oscilloscope on Dashboard => View to determine which stationary beacon is
jammed

-

Reduce the gain of the ultrasonic manually depending on your system

11.16. Sensors settings: example for 2D and mobile beacon

Beacon

Beacon

2D

Hedgehog
7

Beacon 2
RX1 and RX4 emit ultrasound in normal mode
for better ultrasonic signal exchange with
Beacon 3. In frozen mode RX2 added as
working sensor. The rest sensors are turned off
Changing sensors’ settings could be found in
the panel in the upper right corner of the
Dashboard during your beacon is connected to
the computer
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Beacon 3
RX3 and RX4 emit ultrasound in normal mode
for better ultrasonic signal exchange with
Beacon 2. In frozen mode RX2 added as
working sensor. The rest sensors are turned off

11.17. Powering beacons
Depending on the type of beacon, may be internal battery, or external USB power
supply, for more details check comparison table
Battery lifetime totally depends on the mode of operation and can be varied between
several days to several months (or more for special applications)
Learn more here: Power supply options for beacons
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11.18. Power supply and Leds
-

Modem doesn’t have battery, so power supply led is always on, when
Modem connect to computer.

-

Power supply led for battery (for Super-Beacons, Beacons HW v.4.9 and
Mini-RX Beacons) is on, when battery is charging and is off when battery
isn’t charging. Battery stops charging when fully charged, when this
happens, led goes out. So, led turns off and on periodically, what means that
beacon fully charged and led turns on again when battery drops a few
millivolts.

-

You can always find out the battery level by connecting it to Dashboard via
USB or radio.

Status of charge:
-

4.1V - 4.2V – absolutely fully charged

-

3.6V – 4V – good charged

-

3.2V – 3.6V – very low charge

-

3.2V – fully discharged

Learn more here: Power supply options for beacons
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12.

Frequently Asked Questions

Please check this forum for more information. Here we will answer the most common
questions

1 What is the proper way to place the beacons?
-

The actual distance between beacons must be ≤ 30m. Provide the line
of sight from one beacon to minimum two others

2 How far can beacons be located from modem?
-

In the open space the distance from the modem to the beacon can reach
several hundred meters

3 What if hedgehog shown as orange circle or
in the Dashboard?

inside

-

Blue - normal mode and confident tracking

-

Orange - system provides the best location data possible, but
confidence is lower, than blue

-

transparent - lost radio packets or no ultrasound coverage

4 What is the obstacle for ultrasound?
-

The real obstacles for ultrasound are walls (concrete), glass, metal. If
you need to cover a multiple-floor territory you can use our Submap
feature in which case the tracking will not be interrupted

5 How the system works in very low and very high temperatures?
-

System is designed for normal office-like conditions and temperatures 0
ºС - 40 ºС

-

You can see some other types of beacon (outdoor, explosion safe, etc.)
in the comparison table

-

We also possible to produce some special versions, which will suit your
case. Please write to info@marvelmind.com

6 Are beacons resistant to explosions, dust, dirt, water, noise?
-

- Low-frequency noise (motor noise, industrial equipment) does not
interfere with the normal operation of the system

-

You can see some other types of beacon (outdoor, explosion safe, etc.)
in the comparison table

7 What is the time of delay between positioning the object and
respond?
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-

The delay is directly proportional to the update rate. For example, if
update rate is 16 Hz delay is 1.2:1.5x60ms

-

The limit is 1.5x times the maximum distance between the stationary
beacons. To expand the service area, please follow the instructions
shown in the attached screenshot. Notice that positioning the mobile

beacon far from stationary beacons and close to their plane may result
in increased positioning error because of bad geometry of measurement

8 How to define IMU or not IMU beacon?
-

Check white sticker on the box and on the beacon's bottom /IMU - with
IMU

-

Connect beacon via USB: Dashboard => View => Accelerometer data

9 Can we use none-IMU beacon as mobile beacon or not?
-

Yes, you can (https://www.youtube.com/watch?v=A4aRsjH2-_E)

10 What is the reason to choose 915Mhz vs 433Mhz?
-

The 915MHz version is designed for the US, Canada and Americas in
general. The ISM band (license-free band for industrial, science and
medical applications) in those countries is 915MHz

-

In Europe, it is 433MHz

11 Device do not connect via USB?
-

Use USB cable with long metal part. If you have any problems with USB
connection, change the cable first. One cable can work for one device
and do not work for other

12 Does the orientation of the beacon matter?
-

Yes, it is. Place and orientate it in positions, where sensors can “hear”
each other. v4.9 beacon has ≈90° per sensor coverage(illustration),
Mini-RX and Industrial-RX have ≈180° coverage(illustration)

13 Why Dashboard do not see more than 4 beacons
-
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System has a limitation of 4 beacons per submap. If you have more than
4 beacons, just create another submap, and beacons will appear

13.

Troubleshooting checklist

If you have any problems with the system, follow these simple steps:

-

Update SW on modem and beacons

-

Now, connect all beacons and modem one by one and press Default button in the
Dashboard (When updating the SW, please, press Default button to make sure that
beacons really have default settings. Otherwise, modem may be calling on a wrong channel
or something)

-

Press Erase map, when modem connected to PC

-
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13.1. Checklist before starting the system:
IA and NIA SW differs
For IA you should use stationary beacons with different frequencies
Make sure that you use correct SW. Inverse Architecture(IA) SW for Inverse system,
Non-Inverse Architecture(NIA) SW for Non-Inverse system (Architectures comparison)
Make sure that your beacons are 3.5V and higher before using. If not, charge it for 2-3
hours.

-

Keep modem 1-2m away from beacons. if closer, the beacons radio may be overloaded

-

Antenna’s recommendations:

-

The antenna must be kept as straight as possible. Otherwise it will reduce the
effective range
The antennas must be kept away from conductive materials, such as metal and
carbon by at least a half inch
Keep the antennas away from the motors and other noise sources as much as
possible

-

Use USB cable with long metal part. If you have any problems with USB connection,
change the cable first. One cable can work for one beacon and do not work for other

-

Be sure that you use SW from the same pack

-

When updating the SW, please, press Default button to make sure that beacons really have
default settings. Otherwise, modem may be calling on a wrong channel or something

-

Start with simple configuration (10x10m square, 4 stationary beacons)

-

Do not obstruct line of sight between beacons

-

Build the map first, freeze it, then wake up the “hedge”

-

Number of periods. By default – 5 for HW v4.9. 20 for Super-Beacon, 50 for Mini-TX. For
longer distances you can put 10-50

Mini-RX beacon may be over discharged. In that case do the following:

-
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Turn off the beacon with DIP switches
Charge it for 1 hour
Turn the beacon on, flash the latest SW via DFU Programming and charge it for 1 hour
again

14.

Contacts

For more information about company check: About us
For additional support, please send your questions to info@marvelmind.com
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